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Welcome 

A helpdesk system integrated seamlessly within your Microsoft Office Outlook, transforming it from a simple email client 

to a fully-fledged service provider.  

This is an elaborate help documentation that will guide you how to install, configure, and work with support cases in 

matter of minutes. Graphic illustration and screenshots of the screen/forms are used with proper marking wherever 

they are required to drive down the point of the relevant topic.  
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1. Introduction  
You have a business that you aim one day to grow and be profitable. If you have fewer customers, sure, you can provide 

resolution to their grievances by writing or speaking to them, without logging the details of the customer and nor 

documenting the nature of the problem. However, what happens if you have a large customer base? 

• How would you remember who sent what and who needs what?  

• Would you remember if an issue has already been resolved from this particular customer?  

• What if you had solved an issue virtually identical to a separate issue you are currently working on?  

For strategic decisions and intelligence, you would certainly like to know how many times this particular problem come up for 

this particular product has. How long has this problem been an issue for them? 

Why a helpdesk system? 

It is said that success of a business is measured against the level of customer satisfaction on sales and services. In fact, the 

higher the customer satisfaction is the repeated business it creates. This is one of the key reasons why successful enterprises 

have a dedicated help-desk team or call centers to cater to the queries and grievances of their customer base. But what 

makes a help-desk team productive and successful? Well for sure, choosing the right helpdesk system is the first step that can 

make all the difference. 

But how do you arrive to the decision of choosing a particular helpdesk system? Do you need a helpdesk database system that 

works standalone within your local network? Or do you need a web based helpdesk to enable your scattered support 

personnel to work on troubled tickets? Or do you require a helpdesk that make uses of your existing email infrastructure such 

as Microsoft Outlook and Exchange? 

But why in Microsoft Office Outlook? 

Typically, an ideal helpdesk system should support the organizations’ internal logic and workflows, integrates easily and 

leverage existing infrastructures, caters to the support technicians on the move, enables automation and processing based on 

customizable rules and most importantly, should be easy to use with little or no training requirement. This is where a 

helpdesk system based on email client such as Microsoft Outlook scores over other type of support systems. This is because 

you already use Outlook extensively – all day, every day for email communications, appointments, contacts, tasks etc. As you 

have relied that heavily on Outlook, having a sort of a ticketing system in Outlook to support requests and calls from 

customers would be an obvious choice.  

Moreover, as Outlook provides quick access to your contacts, address books, mailboxes and public folders stored on a central 

Exchange server, it makes it much easier for you to track, collaborate and log support requests in Outlook. 

The problems with helpdesks based on Outlook 
Microsoft Outlook is a great productivity office application, something more of an indispensable companion for many 

businesses. However, Outlook itself is highly optimized for personal email exchange often falling short when it comes to 

providing a complete history of an event over time. When an email has been forwarded, the original owner loses insight into 

the progress. This has a serious implication, that is, in its original state, Outlook simply lacks the automation, reporting, 

reminders, and workflow to manage a support ticket request, which is critical for growing helpdesks looking to optimize and 

uniformly improve customer interactions. 

The Solution - Extending your Outlook 
Personal Helpdesk System answers these limitations by integrating itself within the Outlook process (as an add-in) and 

extending it as an ideal platform to collect, track and resolve trouble tickets while sharing this information - all with ease. It 

brings all of help desk functionalities and automation and tightly integrates with the easy workflow of Outlook, thereby 

allowing you to work in the same way you do with emails. What you would get as an IT manager is high rate of user 

acceptance, yet low cost of operation, training and maintenance. 
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Issue tracking with Personal Helpdesk Add-in 
 

Personal Helpdesk is an ITIL guided, issue tracking and ticketing system with integrated asset management that is available as 

an add-on for Microsoft Outlook. It is the only comprehensive helpdesk system entirely integrated seamlessly within your 

Microsoft Outlook, transforming it from a simple email client to a fully-fledged service provider. Using Microsoft Exchange as 

repository for storing support cases, it provides you with all the necessary tools to log, collaborate, analyze and assist in the 

resolution of help desk issues. Various medium of communication supports automated messaging and notification requiring 

no human inputs.  

Apart from e-mail, the ability to send SMS and make phone calls directly from your Outlook extends the exchange of 

information to a new level, thereby, making it possible to integrate customer relationship management (CRM) processes in 

core help desk functionalities. 

With inbuilt support for advanced statistics and varied reporting options, you can evaluate the performance of the helpdesk 

and in-turn ensures timely decision making for improved service. Furthermore, caller can submit new support requests via a 

web form, login to caller web access to track and escalate support cases, check status, or search through the knowledge base, 

all via a web browser for first level support.  

To sum up, Personal Helpdesk improves the efficiency of the help desk to enable faster response time and higher productivity 

for your organization at lower operating costs. After all, the bottom line for your help desk team is for your end-users to 

receive better and timely service. 

Benefits for your organization: 

 Work on cases in your Outlook as if you would work on emails 

 Single enterprise-wide view of support cases, callers, problems and resolutions 

 Little or no training requirement 

 Centralized data storage on Microsoft Exchanger (mailbox or public folder) - efficient platform for collaboration 

 Enable integration with Active Directory  

 Common point-of-call for your callers 

 Structured workflow for all helpdesk activity  

 Freeing up valuable human resources by automating cases logging, sending notifications etc. 

 Higher productivity and increased "up-time" for support staffs  

 Organized state of cases means faster tracking requests 

 Identify problem areas and increase helpdesk efficiency  

 "Do more with less" - affordable one-time fee with enterprise-wide license  

 

Benefits for your customers:  

 Always in communication loop via the power and ease of automated email/messaging 

 Inspires confidence to the help desk service 

 A knowledge base that a caller can search through for resolution to their query 

 Check on the progress or status of the case via web 

 Request support in a standardized way through email, phone calls or web form submission  

 Case get resolved in a timely manner and hence customer satisfaction 

 Helps in building trust and loyalty in your brand 
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How It Works?  
 

Personal Helpdesk makes working on support requests very easy by seamlessly integrating the process of submitting, assigning, 

tracking and fulfilling support requests all inside your much-used Microsoft Outlook! The add-in consists of a simple install, with 

which you can configure and maintain the Helpdesk folders, drop down lists, templates, FAQs and other helpdesk settings. It is 

installed on your computer as an extension to Microsoft Outlook and enables you to work on support cases in Outlook with the 

configured Helpdesk folders. 

   

Step 1. Configure helpdesk settings 

and drop downs 

After successful installation of Personal 

Helpdesk to your system, start Microsoft 

Outlook. You will see that additional menus, 

toolbars or ribbons are added in the explorer 

and inspector windows of Microsoft Outlook. 

You will also find the 'Personal Helpdesk' tab 

under Outlook > File > backstage view, with 

which you can administer the settings of 

Personal Helpdesk, define drop-down lists 

such as callers, problems, assets, as well as 

emails and SMS templates, predefined 

replies, messaging options, web access etc. 

You can also set the Personal Helpdesk to 

monitor any number of mailboxes and email 

folders, for automatic processing of incoming 

emails to support cases. This process cuts the 

overhead of manually generating support 

cases from emails, thus diverting valuable 

human resources to resolving the case. 
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Step 2. Caller submits support 

request via email, web form or 

phone call 

An end-user experiencing technical 

challenges can self-service the answer to 

their problem by accessing the web-based 

knowledge base (through the Personal 

Helpdesk Customer Web Service site). 

If a solution is not found, the end-user 

requests for support by sending an email, by 

making a phone call or simply, by filling a 

web form. These support requests are then 

logged and converted to cases in Outlook. 

Further details and drop-down lists (such as 

the classification of problems the request 

falls into) can then be set. 

 

 

Step 3. Technicians work to resolve the case 

You then proceed to fulfill and resolve the case, either in Outlook. You may enforce a Service Level Agreement (SLA), set due date 

and other deliverables on the particular case, for quality check purposes. Further correspondence to the caller might follow (in the 

form of emails, SMS, phone calls). All activities related to the case are logged and you can fill time spent and notes. Relevant asset 

information and fixes related to the case can be accessed and tracked right from the case form itself.  

Step 4. Caller follows-up via email 

The caller can reply back to email from the helpdesk and the response automatically triggers an escalation on that particular 

support case. If a response from the caller on an existing case is received, you are notified automatically. If the case has been 

resolved, Personal Helpdesk automatically re-opens and marks it as an ongoing case. 
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Alternatively, caller can also choose to escalate, withdraw, reopen or simply track the history of their support cases online by 

logging into the Caller Web Access (CWA) website (that comes with Personal Helpdesk). 

 

Step 5. Close case after providing a 

resolution 

Certain pre-defined Outlook views can be 

used to track the progress of cases. Once 

every parameter of the caller's request has 

been fulfilled, a case be closed. The closed 

case is then moved to the Resolved Cases 

folder. At the same time, the caller gets 

notified automatically on the closure of the 

case. 
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Step 6. Add resolution to knowledge base 

A closed case can be a good source of future reference and you can create a new knowledge base entry based on the case. It is 

then available in the list of articles under the integrated knowledge base, categorized and sorted, ready to draw from when 

similar issues arise. You can publish these articles on to the Customer Web Service site for providing first level support to potential 

support requests from end-users. 

 
 

 

Step 7. Generate statistical and trend reports 

To identify problem areas and increase helpdesk 

efficiency, you can run the statistical tool from 

time to time, collecting valuable intelligence 

and trends and generating meaningful reports.  

 

For day to day knowledge of the helpdesk, you 

can generate summary reports to get appraisal 

on the current happenings on the helpdesk and 

track recent cases generated, worked, closed or 

reopened. 
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Step 8. Archive old cases to database or PST 

Over time, the Personal Helpdesk folders (in Exchange) will be accumulated with support cases mostly resolved ones. You can 

either archive the old case items to a PST file or can export the case data to an external database such as Oracle, SQL or Access. 

Archiving periodically keeps the exchange folder from getting too big and unwieldy, which could cause Exchange/Microsoft 

Outlook performance to slow down. 
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2. Requirements  
Personal Helpdesk is available right inside your Outlook unlike any other standalone application and web based help desk software. It 

can be easily deployed through an installer to your system.  

 

Please make sure that your system meets the following requirements before installing Personal Helpdesk for Outlook: 

Windows Version  Windows Vista, 7, 8, 8.1, 10. Both 32-bit and 64-bit OS are supported.  
  

Outlook Version  Outlook 2016, 2013, 2010, Outlook 2007. Personal Helpdesk operates directly inside the 
Microsoft Outlook application (using Microsoft's "COM add-in" technology). Outlook 
Express is not supported.   
  

.NET Framework  Microsoft .NET Framework 4.5 or Higher. 

 

  

.   
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3. Installation Steps  
Personal Helpdesk system is installed on individual computer as an add-in extension to Microsoft Outlook. No database, file server is 

required. Download link: https://www.assistmyteam.net/PersonalHelpdesk/download.asp 

There are two setup types based on the bit-ness of your Microsoft Office: 

PersonalHelpdeskSetup_x86.zip (for 32-bit Outlook 2007, 2010, 2013, 2016) 

PersonalHelpdeskSetup_x64.zip (for 64-bit Outlook 2010, 2013, 2016) 

Extract these file contents to a file folder. 

Step 1. Run the PersonalHelpdeskSetup_xXX.exe to start the installation. Click 'Next' to Continue. If Outlook 2010 or later is 

not installed, the setup wizard will not be able to proceed.  

 
 

Step 2. Select the appropriate destination folder where the application files will be installed. (Note: by default, it will be 

installed under your application data folder) 

  

https://www.assistmyteam.net/PersonalHelpdesk/download.asp
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Step 3. Click 'Next' to continue with the files extraction. It just takes a few minutes to complete the whole copying process 

  
  

Step 4. Click 'Finish’. This ends the files installation process in your system. Now start Microsoft Outlook 

  

  

 

  



 

 

 Back to TOC 

P
ag

e1
4

 

Step 5. Start Outlook (restart if it was already running during the files installation). As soon as Outlook is loaded, you will be 

prompted with the following dialog box, offering you two choices: 

 

 

Create New Personal Helpdesk folders – Click this button to create new Personal Helpdesk folders (i.e., Ongoing Cases, 

Resolved Cases, KB, Schedules etc.) which are customized with Personal Helpdesk specific fields, views and forms. 

Follow step 6 to further go ahead with the configuration. 

 

 

Use Existing Personal Helpdesk folders – Click this button to use an existing Personal Helpdesk folder (i.e., Ongoing 

Cases, Resolved Cases, KB, Schedules etc.) which had been already configured by you from earlier installation. You will 

be given the option to select the existing Personal Helpdesk root folder, to link up the Personal Helpdesk add-in with 

the existing Personal Helpdesk folders and database. 

 

 

Either you can auto scan to search for the first available Personal Helpdesk folder. If you already know the location 

of the existing Personal Helpdesk folders, you can simply click the ‘Browse’  button to specify it from your Outlook 

and then click ‘Continue’. Steps 6 and 7 would are not applicable, with this route. 
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Step 6. A folders Installation Wizard dialog (as seen below) enables you to customize the name of the parent Personal Helpdesk 

folder that will be created. By default, it has a title of 'Personal Helpdesk'. 

 

Further, you can choose the language specific Outlook forms and Views to install. The following languages are supported:  

English, Español, Norwegian, Danish, Dutch, Deutsch, French, Finnish, Swedish, Portuguese. 

 

 

Step 7. Clicking 'Next' button would enable you to select an Outlook parent folder where the specified Personal Helpdesk root folder 

would be created. Hence make sure you have adequate rights over the selected folder to create a new folder. 

  

The tool would then copy Personal Helpdesk subfolders, forms & designs, views etc. from the Personal Helpdesk PST template file. It 

would look like the followings layout (right side): 

NOTE: When you start Outlook, if you are not prompted for the option to copy a new Personal Helpdesk folder, or choose existing 

one, then most likely, there might be remnants of earlier installation. In such scenario, go to Outlook > Personal Helpdesk menu and 

click ‘Copy a New Personal Helpdesk folder’. That will manually invoke the wizard tool for copying a new Personal Helpdesk folder 

to your Outlook 
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The installation and configuration in your Outlook is performed 

successfully. You can now choose to load the demo samples 

from Outlook > File > Personal Helpdesk > Demo Cases. 

You can specify the number of sample ticket items to be 

created for Ongoing Cases/Resolved Cases as well as KB 

articles. Loading the demo cases will also load a sample 

data/configuration under Callers List, Assets List, and 

Problems List etc. You can of course delete these sample 

cases and data later on when you want to use for your live 

support. 

 

The screenshot below lists all the files that are installed on the system.  

The add-in files are targeted under current user’s application data folder. 

E.g. C:\Users\[USER]\AppData\Roaming\AssistMyTeam\Personal Helpdesk for Outlook (x64 or x86) 

 

Template PSTs/Forms/Web Access files under current user’s application data folder. 

E.g. C:\Users\[USER]\AppData\Roaming\AssistMyTeam\Personal Helpdesk Resources 
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4. Administrative Settings   
The Personal Helpdesk add-in include list managers to customize the contents of all drop-down boxes on the help desk form, 

predefined answers, templates for outgoing emails and SMS, notification options, incoming emails monitoring, messaging, custom 

fields etc. Besides managing the settings and drop-down lists, it is responsible for monitoring email folders and mailboxes for 

automatic processing of incoming emails to support cases, as well as processing web requests coming from Customer Web Service 

(CWS) website (if configured).  

 

Personal Helpdesk Menu 

The Personal Helpdesk menu serves as the gateway for launching most of the functionalities and tools available in Personal 

Helpdesk for Outlook. In Outlook 2016, you would find the Personal Helpdesk menu in the backstage file button, as shown 

below. 
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4.1 Assets Configuration and Tracking 
 

The helpdesk is a vital part of the company who wants to get the most out of its IT assets. The assets list allows you to track and 

manage support request from your internal users for quick resolution to the case. There are 5 asset fields available out of which 4 

are customizable according to your need. Out of the 4, 2 of them are drop-down fields. In the above screenshot, we have taken the 

example of computing resources used by internal staffs. We have customized the 2nd and 3rd fields as Asset type and Asset OS, 

which takes a drop-down list. Both the drop-down lists are available on the right. The 4th and 5th fields (e.g. Asset IP, Asset Make) 

take the normal text data.  

 

The titles of these customizable fields can be set in 'Asset Fields' settings. 

 

 
Input a unique identifier name of the asset. 

 
Input a title for the 2nd field of the asset. This takes a drop-down list which you can define under the first tab of right 

side. 

 
Input a title for the 3rd field of the asset. This also takes a drop-down list which you can define under the second tab of 

right side. 

 
Input a title for the 4th field of the asset. This takes a static text type. 
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Input a title for the 5th field of the asset. This also takes a static text type. 

 
Allow addition of new asset that was entered in the case form to the global assets list and save to the database. 

 
Give a title that best describe the asset or equipment you are trying to tracking with Personal Helpdesk. 

 

Additional Asset fields 
 

By default, Personal Helpdesk has provision for 5 predefined asset fields. However, if you need more, the you can and add any 

number of secondary asset fields that takes varying data types such as text, number, yes/no, note, date or currency under Personal 

Helpdesk > Asset Fields panel (Additional Fields, Additional Lists tabs). All defined custom fields are available in summary reports 

and OLAP Statistics tool. 
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4.2 Callers list  
 

Personal Helpdesk can maintain the detail of the callers that request for support. The caller's email address is a mandatory 

field and should be unique for each caller that you entered. If there has to be phone calls to callers from within Personal 

Helpdesk (say, from the outlook form), the phone and mobile need to be filled up. The mobile field is also necessary if callers 

have to receive SMS notifications in their mobile device. The department field has a restricted range (as being a drop-down 

field) i.e., it can take only take a value from the caller categories.   

 

 

Import callers from Global Address List/Active Directory - Most likely, you might already have contact details of 

the callers in the exchange global address list. Use the 'Import...' button to display the address book and select 

those contacts that you want to import. The contact's name, email, department, company, address, telephone, 

mobile fields would be then automatically filled in the grid. 

 

Caller Web Access (CWA) Password - To access the Caller Web Access (CWA) site from a web browser via the 

internet, the caller requires a password.  You can define this password in Personal Helpdesk > Callers list when a 

new caller is added. Alternatively, it can be generated automatically when a new, non-existent caller is added to 

the Personal Helpdesk callers list. The password can then be set to insert into the notification/confirmation email 

sent out to caller first time when a support case is logged from their email/call/web submission 

 

Default SLA - Each caller entry can also take a default technician. This is useful if you want to dynamically assign 

this default technician to a case (just generated from an email or a web form submission) send by a particular 

caller (that exist in the Personal Helpdesk callers list). This setup automatically triggers the notifications to the 

concerned technician in the form of email, SMS etc. 

 

Associated Users – Each caller entry can be assigned with own stakeholders (or known as associated users) such 

that these users also receive the caller specific notifications from the helpdesk. 

  

Departments & Companies 
Specify what all internal departments your help desk team would support incoming service requests from callers. You can 

then use a category/department to associate each caller. You can also specify the default hourly rate for each department, so 

that, when using statistics, you can consider this rate, besides the other two rates - technician rate and problem category rate. 
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4.3 Technicians List  
 

Personal Helpdesk System needs to maintain your detail (as technician). Your name and email address are mandatory fields. If 

you want to receive SMS notifications, you can enter your mobile number too.  
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4.4 Categories, Types and Statuses Management  
 

Problem management is critical to ticketing system. After detecting a problem, you should log and categorize the problem 

into a main category and secondary type. This step is beneficial in several ways.  

• Allows the helpdesk to sort and model incidents that occur regularly. 

• Allows for automatic assignment of prioritization such as agents, Service Level Agreements (SLA).  

• Ability to gather and report on helpdesk tickets data. This data allows the organization to not only track problem 

trends, but also to assess its effect on service demand and helpdesk capacity. 

With Personal Helpdesk, you can maintain a list of problems (as categories, types, statuses) that is representative of all 

possible incidents reported by your end users. 

 

 

Problem categories list 

Gather all the problem areas that your support team will be attending to and feed them into the 'Category' field. 

You can also specify the default hourly rate for each problem category, so that, when using statistics, you can 

consider this category rate, besides the other rate - caller department. 

 

Problem statuses list 

As technicians start working on assigned cases, over time, they may need to update the state of the tagged 

problem so that you can track and plan additional resources if needed to resolve that particular case. Such a list of 

status flags can be specified. 

The color code column allows you to associate a 

color with a status. And case item in Outlook that is 

tagged with a problem status will be colorized with 

the associated color.  

You can choose from one of the 20 colors 

supported by Outlook for color coding Outlook 

items (via Categories field of the Outlook item).  

To specify a color code for a status, double-click the 

corresponding second cell (color code column).  

When you set the status of the case or when the add-in does that automatically using the default status values set 

for various events, you will see that the categories column of the case item has color-coded status. 
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(NOTE: For color coding of cases with status color code, you need to enable the option 'Allow Color Coding of Case 

items based on the status of the case' from Personal Helpdesk > Automation Options > Other Information)  

And if you preview the case or view it in the case form, you will also see the color bar in the header. 

 

 
 

 

Problem Field List 

This is customizable drop-down field that is provided to complement the multiple hierarchical representation of 

the problem type.  

This field appear in the Outlook case form, (just like the 

Problem Category and type fields) and selecting a particular 

problem type would automatically populate the 

corresponding value for this field too.  

You can change the title of this problem field. By default, it 

is named as 'Problem Field', but you can change it to suit its 

purpose. For example, in the screenshot above, this special 

problem field is named as ‘Zone’, and the possible values 

are defined in the list. 

 

When you open the case form, you will see a new field 'Zone' is now available with a drop-down field. When you 

select a particular problem type, the value of this problem field (i.e., Zone) would be automatically assigned, based 

on the linked relationship, that existed in the Problems list. Lastly, this new column (or field) should also be 

available in the summary reports and OLAP Statistics tool. 
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Problem types list 

The problem types are sub-category items that fall within the domain of a problem area/category. Hence, each problem 

category has a specific list of problem types that you can choose from and tag a support request case.  

 

In the Outlook case and knowledge base form, when a technician selects from the problem category drop down, it will load 

this tier of problem type lists in the type drop-down box. These nested tiers of categories/types are complete customizable to 

your organization's support model and act as somewhat of a guiding decision tree for the caller (when submitting online 

service request) and technicians etc. 

 

 

Problem Category to which this problem type belongs to. If a particular problem type is applicable to all problem 

categories, leave it as empty. That is, if you have a common problem type for all Problem categories, you don’t 

need to add the same problem type for each category. Just leave the Problem Category column empty for that 

problem type. 

 

Default time (in minutes) under which the particular problem is expected to be fixed/resolved. 

 

Default SLA under which the problem fits into. A problem’s priority is determined by its impact on users and on 

the business and its urgency. Urgency is how quickly the organization requires a resolution to the problem. The 

impact is a measure of the extent of potential damage the problem can cause the organization. Prioritizing the 

problem allows organizations to mitigate damage to the service level agreement (SLA) by reallocating resources as 

soon as the issue is known. 

 

Choose a default problem field (titled as ‘Zone’ in our example) from the drop-down list for a problem type. 

 

Code – This is an abbreviated code that you can define for each problem type. This could be one of the tracking 

code that you can configure for embedding into the subject of the case item (along with the case ID) for easy 

recognition and tracking. 
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4.5 Custom Fields  
 

You can deploy any number of custom fields that take different data types and these fields will be available in the Custom 

fields tab of the case form in Outlook, such that, when you are raising a ticket from an email or phone call, you can fill in the 

value directly. All defined custom fields are available in summary reports and OLAP Statistics tool.   

You can define such custom fields that take the following data types:  Text, Number, Currency, Yes/No, Date/Time, Note or 

drop-down List. 

 

 

 

Custom fields can be of 6 different data types as displayed in the image above:  

Currency, Date/Time, Numeric, Text, Yes/No, Note. 

You can add any number of Custom fields as required and they will all appear in the case form in Outlook. 

 

You also have the option to even mark a custom field Mandatory, so that without filling the mandatory fields, a case 

couldn’t be mark completed. Once a field is marked mandatory it would be displayed in red color so that user can 

identify the mandatory fields. 

 

 

Custom List - The titles of these custom list can be edited to get the proper meaningful label that signifies the 

information the field store. For example, the first drop down field can be titled as ‘Client’ and you can fill up the names 

of all their clients for which projects are contracted for.   
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When you open a case in Outlook, the custom fields are available to collect further data on the caller or problem or related to the 

case in general. 
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4.6 Access Control  
 

In this panel, you can control what particular subset of features and options are enabled in the case form in Outlook.  

 

   

 

 
Allow conversion of non-mail items to support case - You can also define which particular type of Outlook items are 

possible candidates for generating support request cases. By default, support requests can be generated from mail items 

only. To enable other Outlook item types, select the appropriate checkboxes - Post, Meeting or Task. 

 

 
Disable balloon popup notification - Disable a balloon popup notification when a major event occurred in Personal 

Helpdesk System. By default, it is unchecked. 

 

 
Open Support Case form automatically when it is generated from other Outlook items - Enable this option to 

display/open the inspector window of the support case just created. This is only applicable when the case is generated 

manually from an email or other Outlook item. 

 

 
Open knowledge base form automatically when it is generated from other Outlook items - Enable this option to 

display/open the inspector window of the knowledge base just created. 
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4.7 Origin List 

 
In Personal Helpdesk, a case could be raised from different source such as an email, phone call, contact, or from web form. In 
the case form, a ‘Origin’ field is provided that shows the source of the case. You can add the number of difference origin a 

case could be originated from.  

 

And further, each origin in the list can be mapped or associated with the predefined header under 

Personal Helpdesk > Origin Options. 

 

 

Choose an origin value (defined in the Origin List) that will be associated with cases that were raised from Outlook 

emails. 

 

Choose an origin value (defined in the Origin List) that will be associated with cases that were raised from Outlook 

tasks. 

 

Choose an origin value (defined in the Origin List) that will be associated with cases that were raised from Outlook 

appointments. 

 

Choose an origin value (defined in the Origin List) that will be associated with cases that were raised from Outlook 

contacts. 

 

Choose an origin value (defined in the Origin List) that will be associated with cases that were raised from phone 

calls. 

 

Choose an origin value (defined in the Origin List) that will be associated with cases that were raised from web 

form (Technician Web Access site). 

 

Choose an origin value (defined in the Origin List) that will be associated with cases that were raised from web 

form (Customer Web Service). 
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4.8 Templates Manager  
 

Personal Helpdesk uses various templates (emails as well as SMS) for sending out notifications and reminders to callers and 

technicians - both manual and automatic. Email notifications take HTML format whereas SMS notifications use plain text. 

There are a whole lot of notification options for different events such as when a case is created, changed or resolved, or when 

a technician is assigned to the case, or when the due date has lapsed etc. Automated emails and SMS are sent out directly 

when a relevant event occurs and the whole exercise is transparent to the technicians. 

 

 
 

 

A list of all templates used for print, email or mobile SMS. The followings are the available templates: 

 

Template Purpose 

New case HTML template used in logging new support request case (applicable 

on both manual and automatically created cases) 

 

Print HTML template used when printing the support case item in Outlook 

 

Email caller from case form HTML template used when contacting the caller of a case 

 

Email caller on case closure HTML template used in the automated email to the caller to notify 

about the successful resolution to the allotted case 

 

Email technicians on case assignment HTML template used in the automated email to the technicians to 

notify when a case is assigned 

 

Email technicians on case reopening HTML template used in the automated email to the concerned 

technicians when a resolved case has been re-opened 

 

Email technicians on due-date lapse HTML template used in the automated email to the concerned 

technicians when the due date of a case is about to be overdue 

 

Email technicians on respond by date 

lapse 

HTML template used in the automated email to the concerned 

technicians when the respond by date of a case is about to be overdue 
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Email caller on technician assignment HTML template used in the automated email to the caller when new 

technicians are assigned or existing ones changed 

 

Email technicians on caller reply HTML template used in the automated email to concerned technicians 

to inform about new replies from the caller 

 

Email supervisors on SLA breach (Due 

Time) 

HTML template used in the automated email to helpdesk supervisors to 

inform about SLA breach occurrence on due time lapse 

 

Email supervisors on SLA breach 

(Response Time) 

 

HTML template used in the automated email to helpdesk supervisors to 

inform about SLA breach occurrence on response time lapse 

 

Email Supervisors on New Case HTML template used in the automated email to supervisors to inform 

about a new case 

 

Email Supervisors on case closure 

 

HTML template used in the automated email to supervisors to inform 

on the completion and closure of a case 

 

SMS caller from case form Plain text template used when contacting the caller of a case 

 

SMS caller on case allotment Plain text template used in the automated SMS to the caller to notify 

about the successful logging of the support request 

SMS caller on case closure Plain text template used in the automated SMS to the caller to notify 

about the successful resolution to the allotted case 

 

SMS technicians on case assignment Plain text template used in the automated SMS to the technicians to 

notify when a case is assigned 

 

SMS technicians on case reopening Plain text template used in the automated SMS to the concerned 

technicians when a resolved case has been re-opened 

 

SMS technicians on due-date lapse Plain text template used in the automated SMS to technicians when the 

due date of a case is about to be overdue 

 

SMS technicians on respond by date 

lapse 

Plain text template used in the automated SMS to technicians when the 

respond by date of a case is about to be overdue 

 

SMS caller on technician assignment Plain text template used in the automated SMS to the caller when new 

technicians are assigned or existing ones changed 

 

SMS technicians on caller reply Plain text template used in the automated SMS to concerned 

technicians to inform about new replies from the caller 

 

  

 

The actual template in its raw state. A WYSIWYG HTML editor with which you can customize the contents, apply 

HTML formatting as well as insert the placeholder variables. The look and feel as well as the buttons and 

functionalities are similar to Microsoft FrontPage authoring tool. 

 

 

Subject of the active template. It is also customizable and can take placeholder variables. 

 

A list of all placeholder variables available for inserting into a particular template.  In runtime (that is, when the 

actual email or SMS is generated from the template), the enclosed variables will be substituted by their 

corresponding values. The followings list all the supported variables: 

Variable Purpose 

SDO_CASEDESCRIPTION Description of the support request case 

SCO_EMAILBODY Body of the caller email 

SCO_CASENUMBER Case Number of the generated support case 
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SCO_SUBJECT Subject of the email or the support case 

SCO_CASEAUTHOR The help desk staff that created/logged the 

support request 

SCO_DATERECEIVED Date and time the email was received 

SCO_DATECREATED Date and time the support case was 

created/logged 

SCO_PROBLEMCATEGORY Problem category to which the case belongs to 

SCO_PROBLEMTYPE Problem type to which the case is related with 

SCO_STATUS Status of the case with regards to the problem 

SCO_EMAIL_HISTORY_LISTING Email history listing on the current case 

SCO_TIMESPENT_DESCRIPTION Description on each time that a technician spent 

in working on the case 

SCO_TOTAL_TIMESPENT Total time spent (in minutes) on the case 

SCO_LOGS Log listings related to the case 

SCO_NOTES Nodes added on the case by technicians  

SCO_CALLERNAME Name of the caller who had requested for help 

SCO_CALLEREMAIL Email address of the caller 

SCO_CALLERPHONE Telephone number of the caller 

SCO_CALLERMOBILE Mobile number of the caller 

SCO_CALLERDEPARTMENT Department to which the caller belongs 

SCO_CALLERADDRESS Full address of the caller 

SCO_TECHNICIANS Technicians assigned to the case 

SCO_DUEDATE Due date assigned to the case within which the 

case has to be resolved 

SCO_PRIORITY Priority of the case 

SCO_ASSETNAME Asset name related to the case 

SCO_ASSETCOMMENTS Comments on that particular asset 

SCO_NOW Current date and time 

SCO_CUSTOMFIELD1 Custom Field 1 

SCO_CUSTOMFIELD2 Custom Field 2 

SCO_CUSTOMFIELD3 Custom Field 3 

SCO_CUSTOMFIELD4 Custom Field 4 

SCO_REPLIEDEMAILBODY Description body of the caller replied email 

SCO_REPLIEDEMAILSUBJECT Subject of the caller replied email 

SCO_WEBACCESS_LOGIN Caller login details for web access 

SCO_WEBACCESS_URL The web URL of the Caller Web Access (CWA) site 

SCO_KBBODY Description body of the newly published KB 

article 

SCO_KBSUBJECT Subject of the newly published KB article 

SCO_KBPROBLEMCATEGORY Problem Category of the newly published KB 

article 

SCO_KBPROBLEMTYPE Problem Type of the newly published KB article 

SCO_KBLINK Outlook link of the newly published KB article 

clicking which will open the KB article 

SCO_KBCREATEDDATE 

 

Creation date of the newly published KB article 

  

 

Reset button – click this to reset any changes made to the selected template and revert back to the original 

template content. 
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Allotment Templates 

 

 

An allotment template is used for notifying caller when a case is raised from their support request. In Personal Helpdesk, you can 

define multiple allotment templates, so that one can choose which specific allotment auto-response to send to a particular caller. 

For instance, if someone sends an e-mail to UK.Support@myCompany.com, you would want to inform the customer that their e-

mail will be responded to within 2 hours between 9 am and 5:30 pm GMT. If they send a new case to US.Support@myCompany.com, 

you can inform the customer that their e-mail will be responded to within 3 hours between 9 am and 5:30 pm EST. 

 
Create a new allotment template based on default content. 

 
Create a new empty allotment template. 

 
Rename the selected allotment template. 

 
Delete the selected allotment template. 

 
List of all allotment templates available. 
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4.9 Notification Options  
 

Automatic Email and SMS Notifications - Automatic email notification and SMS alerts are essential for keeping callers and 

technicians informed with the progress and status of the case. Personal Helpdesk offers a whole lot of notification options for 

different events such as when a case is created, changed or resolved, or when a technician is assigned to the case, or when 

the due date has lapsed etc. The template for such a notification email or SMS is available for customization as discussed 

earlier. Automatic emails are sent out directly when a relevant event occurs and the whole exercise is transparent to the 

technicians. Same is the case of automatic SMS messaging.  

Check the box of email or SMS of the corresponding notification that you want to enable and then click 'Save' button.  

 

 

Email Alerts 

Here you can enable or disable automated email notifications. To enable a particular email notification, check the 

corresponding box. 

 

NOTE: To customize the template of each of the notification as per your requirement, use the Templates Manager. 

 

 

SMS Alerts 

Here you can enable or disable automated SMS notifications. To enable a particular SMS notification, check the 

corresponding box. 
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Automated Email Notification Samples 
Here are few samples of automated email notification as send to recipient from Personal Helpdesk 

Email notification to caller when a support case is logged from an email/call 
As soon as a support case is logged with Personal Helpdesk and saved in Outlook/Exchange, a notification email is send out 

automatically to the caller (using a customizable template) informing about the detail of the generated case including the 

case number. 

 
 

Email notification to caller when technicians are assigned to their cases 
A simple example is when a new case is generated, and the helpdesk manager assigns it to a new technician. As soon as it is 

saved and exited out of the case, Personal Helpdesk automatically send out the notification email to caller (using a 

customizable template) informing about the assignment of the new technician. If existing technicians are changed, the 

same notification would trigger and the caller is updated to put on the communication loop. 
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Email notification to caller when a case is closed 
When a technician marked a support case as fixed, it is closed and move to the 'Resolved cases' folder. At the same time, a 

notification email is send out automatically to the caller (using a customizable template) informing about the closure of the 

case. 

 

 

Email notification to assigned technicians when a case is reopened 
This scenario would happen when the caller replies back to a support case that had been already marked as resolved in 

Outlook/Exchange. Personal Helpdesk would then automatically reopen the case and sent notification email to the assigned 

technicians. When reopened, the particular case would be moved from the 'Resolved Cases' folder to the 'Ongoing Cases' 

folder. 
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Email notification to assigned technicians when the due date is about to lapse 
This scenario would happen when the caller replies back to a support case that had been already marked as resolved in 

Outlook/Exchange. Personal Helpdesk would then automatically reopen the case and sent notification email to the assigned 

technicians. When reopened, the particular case would be moved from the 'Resolved Cases' folder to the 'Ongoing Cases' 

folder. 

 

Email notification to technicians when a case is assigned 
An automatic notification email would be sent out to the assigned technicians when cases are assigned. 

 

 

 

  

  



 

 

 Back to TOC 

P
ag

e3
7

 

Automated SMS Notification Samples 
Here are few samples of automated SMS notification as send to recipients from Personal Helpdesk 

SMS notification to caller when a support case is logged from an email/call 
As soon as a support case is logged with Personal Helpdesk and saved in 

Outlook/Exchange, a notification SMS is send out automatically to the 

caller (using a customizable template) informing about the detail of the 

generated case including the case number. 

 

 
 

SMS notification to caller when technicians are assigned to their cases 
A simple example is when a new case is generated, and the helpdesk 

manager assigns it to a new technician. As soon as it is saved and exited 

out of the case, Personal Helpdesk automatically send out the 

notification SMS to caller (using a customizable template) informing 

about the assignment of the new technician. If existing technicians are 

changed, the same notification would trigger and the caller is updated 

to put on the communication loop. 

 

 

 

SMS notification to caller when a case is closed 
When a technician marked a support case as fixed, it is closed and move 

to the 'Resolved cases' folder. At the same time, a notification SMS is 

send out automatically to the caller (using a customizable template) 

informing about the closure of the case. 
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SMS notification to assigned technicians when a case is reopened 
This scenario would happen when the caller replies back to a support 

case that had been already marked as resolved in Outlook/Exchange. 

Personal Helpdesk would then automatically reopen the case and sent 

notification SMS to the assigned technicians. When reopened, the 

particular case would be moved from the 'Resolved Cases' folder to the 

'Ongoing Cases' folder. 

 
 

SMS notification to assigned technicians when the due date is about to lapse 
This scenario would happen when the caller replies back to a support 

case that had been already marked as resolved in Outlook/Exchange. 

Personal Helpdesk would then automatically reopen the case and sent 

notification SMS to the assigned technicians. When reopened, the 

particular case would be moved from the 'Resolved Cases' folder to the 

'Ongoing Cases' folder. 

 
 

SMS notification to technicians when a case is assigned 
An automatic notification SMS would be sent out to the assigned 

technicians when cases are assigned. This includes for technicians 

assigned automatically due to relationship defined between a default 

technician and a problem type/caller such as support request submitted 

via web form or when existing a caller sends an email. 
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Adding Attachments to automated notification emails 

 

 

 

Attachments to include in case allotment notification - Often most helpdesk policy requires that certain 

documents such as EULA, disclaimer or Service agreements etc., are also send along with the automated email to 

the caller when a ticket is allotted. 

 

NOTE: Such document files should be placed on a network shared folder e.g., \\Server\File so that, Personal 

Helpdesk add-ins of all technicians are able to access the files from their systems on the network. 

 

 

Attachments to include in case completion notification - And likewise, you can configure Personal Helpdesk add-

in to include certain documents when sending out the automated email about case closure to the caller. 

NOTE: Such document files should be placed on a network shared folder e.g., \\Server\File so that, Personal 

Helpdesk add-ins of all technicians are able to access the files from their systems on the network. 
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Associated Users Alerts 

 

 

Often a helpdesk may have the requirement to link certain stakeholders, apart from the caller, to a support case. These can be 

external vendors, contractors or secondary field technicians whose inputs or contributions are required in resolving the case. 

In Personal Helpdesk, we refer these stakeholders as ‘Associated users’ and these can be added to a case, either by choosing 

from contacts in your Address Book (or Global Address List - GAL). 

 

Alert associated users with caller specific automated notifications 

Enable this option to also notify any associated users of a case with the same set of notifications that are send to 

the caller. 

 

Alert associated users with technician specific automated notifications  

Enable this option to also notify any associated users of a case with the same set of notifications that are send to 

the assigned technicians. 

 

BCC associated users when responding to caller through ‘Email to Caller’ template  

Enable this option so that any associated users of a case also receive a copy of the email communication that is 

send to the caller by the technician through the ‘Email to Caller’ button of the case form in Outlook. 

 

BCC associated users when replying to caller  

Enable this option so that any associated users of a case also receive a copy of the email reply that is send to the 

caller by the technician in Outlook. 

 

BCC associated users when responding to technician through ‘Email to Technician’ template  

Enable this option so that any associated users of a case also receive a copy of the email that is send to the 

assigned technician through the ‘Email to Technician’ button of the case form in Outlook. 
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Group Alerts 

 

 

 

Alert the following users when a new case is generated 

When enabled, with this feature, you can specify users or stakeholders that are to be notified once a new case is 

generated. Clicking the 'Choose...' button would allow selection of the contacts from the address book/Global 

Address lists etc. 

 

NOTE: If multiple users are specified, each email address is separated by a semi colon. 

 

 

Alert the following users when a case is closed 

When enabled, with this feature, you can specify users or stakeholders that are to be notified when a case is 

completed and closed. Clicking the 'Choose...' button would allow selection of the contacts from the address 

book/Global Address lists etc. 

 

NOTE: If multiple users are specified, each email address is separated by a semi colon. 
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Admin Notifications 

 

 

 

Automatically alert the administrator when an email is received on a non-existent case in the monitored 

folder/mailbox  

Enable this option so that helpdesk add-in can send a notification to the administrator (you) informing about a 

non-existent case, when a reply to a non-existent case is received from the caller in the monitored list of 

folders/mailboxes. 

 

Automatically alert the administrator when one tries to generate a case from an email of unlisted domain  

Enable this option so that helpdesk add-in can send a notification to the administrator (you) if a technician tries to 

raise a new case from an email that is not from the administrator approved list of domains. 

NOTE: Approved domains can be defined under Personal Helpdesk > Callers List > Company tab 

 

Automatically alert the administrator when an email fails to get processed (which then is moved to the 

conflicted email subfolder)  

Enable this option so that helpdesk add-in can send a notification to the administrator (you) when it failed to 

create a case from an email, or failed to add a reply from the caller to the associated case. 
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Configure Alerts Workflow 
   

  

 

Alert on ‘Due Time’ lapse should be sent to technician 

When the due date of a case approaches or is about to be lapsed, you can specify how and when Personal 

Helpdesk add-in should notify the assigned technicians (of the case).  

 

For instance, if you want the add-in to notify the technicians only after the due date has lapsed, then choose the 

first option ‘On Lapsed’. 

 

On the other hand, if you want the technicians to be warned well before the due date is about to be lapsed, then 

choose the second option ‘When it is about to lapse in’ and specify number of hours before such notifications are 

to be sent to the technicians. 

 

Alert on ‘Response Time’ lapse should be sent to technician 

When the respond by date of a case approaches or is about to be lapsed, you can specify how and when Personal 

Helpdesk add-in should notify the assigned technicians (of the case).  

 

For instance, if you want the add-in to notify the technicians only after the respond by date has lapsed, then 

choose the first option ‘On Lapsed’. 

 

On the other hand, if you want the technicians to be warned well before the respond by date is about to be 

lapsed, then choose the second option ‘When it is about to lapse in’ and specify number of hours before such 

notifications are to be sent to the technicians. 

 

Force Send/Receive action to immediately start the automated email delivery  

When this is enabled, the add-in will bypass the Outlook queue to immediately start delivering any automated 

email notifications. Only use this feature if your Outlook is taking time to deliver emails from the Outbox. 

 

Include attachments from the case to automated notification email  

If enabled, the add-in will include copies of the attachments, if present in the case item, into the automated 

notification emails. 
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Allow technician to edit the newly generated case (from email) before sending the automated alerts)  

By default, when generating a case from an e-mail (through the 'Convert to Case' button), the add-in assigns a new 

ID and accordingly, the allotment and technician notification e-mails are sent instantly.  

However, if your helpdesk workflow requires that the technicians add more information to the new case, like an 

attachment or caller address etc., before the add-in can send out the automated notifications, you can enable this 

option. When enabled, the helpdesk add-in would display the newly generated case instantly allowing the 

technician to alter/add information such as custom fields, attachments or assigning it to another technician, for 

example. Only when the technician clicks 'Save' button, the add-in will assign a new ID and send out the 

notification to the caller/assigned technicians. 

 

Don't use default template in replies made from case form 

If enabled, when technician clicks the 'reply to last email' button in the case form and no recent replies from the 

caller exists, the add-in will use a blank template instead of the ‘Email to Caller’ template. 
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4.10 Advanced Options  
 

With the advanced options, you can control and streamline how you interact and complete cases in Outlook.   

 

 
Only process incoming emails from existing caller lists 

Check this option to only process support requests coming from callers that already existed in the Personal Helpdesk 

callers list. Any emails from outside the caller list are simply ignored by the add-in. For monitored folders and mailboxes, 

emails that are not from the callers list are moved to a subfolder 'Unprocessed Emails'. Please note that, to use this 

feature, technicians would need to have a higher permission (such as Publishing editor or owner) over the monitored 

mailbox or folder. By default, this option is disabled. 

 

You can compile a list of your callers in Personal Helpdesk > Callers List. 

 
 

 
Only process incoming emails from domain names listed under companies list 

By default, helpdesk add-in can raise support cases from any emails. However, if your support policy is only confined to 

customers from known or trusted companies or domains, you could configure Personal Helpdesk to only process helpdesk 

related activities and workflow from emails sent from admin specified domain names. And emails from outside the 

trusted domains would be skipped.  

 

To implement this selective processing policy, you need to define such list of trusted domains under Personal Helpdesk > 

Callers List > Company tab. 
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So, when you or other technicians try to generate a new case from an email send from an unlisted domain, Personal 

Helpdesk would not process and instead a popup message would be shown that the email sender domain is not trusted. 

And if Personal Helpdesk add-in was monitoring a mailbox (support account for example), and when a new email is 

received from unlisted domains (e.g., not in the Personal Helpdesk > Company list), the email would be moved to a 

subfolder called 'Unlisted Domain Emails' for your references. 

 

 
Allow multiple conversion of Outlook items to support cases in a single click 

To increase productivity, this option enables a technician to convert multiple selected Outlook items such as emails, 

appointments or tasks to support request cases in a single-click. Use the 'Convert to case' button to achieve this. By 

default, Personal Helpdesk processes a single email to support case, no matter how many emails were selected. 

 

 
Allow multiple cases operation (Delete/Print/Resolved/Create KB) in a single click 

This option enables a technician to batch-process any support case specific operations such as marking as resolved, 

deleting, printing, re-opening etc. on multiple support cases. By default, Personal Helpdesk processes a single support 

case when such operation is initiated. 

 

 
Allow technicians to edit the time stamp when editing time spent 

By default, the time stamp of any time spent entries made in a case by technicians are read-only. That is, once a entry is 

made, the technician can’t change the time stamp, though they might be able to edit the time spent value. 

 

 
 

But if you want to allow your technicians to edit the time stamp of the time spent entries made on cases too, enable this 

option. And the ‘Edit Time’ dialog box will allow technicians to pick a date and override the existing one. 



 

 

 Back to TOC 

P
ag

e4
7

 

 
 

 

 
Check which hourly rate to use for calculating the cost of supporting the case in statistics 

Specify which hourly rate to use in statistics in calculating cost - technician rate, problem rate, department rate or 

company rate. This is useful if the organization use hourly rate to pay technicians. 

 

NOTE: To add or modify the hourly rate, refer below 

For technician rate: Personal Helpdesk > Technicians List > Hourly rate 

For problem rate: Personal Helpdesk > Problems List > Categories 

For department rate: Personal Helpdesk > Callers List > Departments 

For Company rate: Personal Helpdesk > Callers List > Companies 

 

 
Show Duration in reports as 

When you run reports or statistics, you have a choice to display duration fields (such as Open Duration, Resolution 

Duration, Response Duration, Elapsed Duration) in either Days, Hours or Minutes. 
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Configuring Outgoing Accounts 
 

  
 

In Personal Helpdesk > Advanced Options > Outgoing Accounts tab, you can specify which mailbox account would Personal 

Helpdesk add-ins use to send out the automated notification alerts and replies to callers and technicians. 

 

 

When you select the first option 'None', Personal Helpdesk will use the default/primary mail account that is 

configured on the Outlook profile to send out the alerts and replies. You should use this option if you want each 

technician to send out the auto-alerts and replies from their associated default account. 

 

However, if you want a centralized or single account to use for all outgoing emails and alerts, choose the second 

option 'Use this particular account'. This is ideal if you have a common account (e.g., support@yourdomain.com) 

and you want the replies and auto-alerts received by the caller to appear to come from this common account (in 

the from field of the email) no matter which technician is replying/sending those alerts/emails from their Outlook.  

Note: To work with this feature, you need to have 'Send on behalf' rights. You do that from the windows server: 

Active Directory Users and Computers > Common account > Properties > Exchange General > Delivery Options. 

 

 

When both 'Send As' and 'Send Behalf of' are enabled, the add-in will try to use the 'Send As' permission as first 

preference. If that fails, it will fall back to using 'Send behalf of'. 

 

The last option is to configure Personal Helpdesk to send out notification emails and responses, using the 'Original 

Email recipient mailbox account'. For example, assume you have two mailboxes, Support and Sales. And you 

receive support request email, say email A, to Support mailbox, and email B, to Sales mailbox. When Personal 

Helpdesk processes and generates a case from each of these emails (either manually or automatically), Personal 

Helpdesk will use the recipient account, for sending out the notification emails. So, when sending notification 

email to Caller A, Personal Helpdesk will send it from Support account. i.e., the from: field of the email will have 



 

 

 Back to TOC 

P
ag

e4
9

 

Support address, as the sender. Likewise, when sending notification email to Caller B, it will be sent from Sales 

account. i.e., the from: field of the email will have Sales address. 

NOTE: You and other technicians, still need to have 'Send behalf' permission over the Support and Sales 

mailboxes. Otherwise, you will receive an error response from your Exchange Server, regarding inadequate 

permission to send email from that particular account. 
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KB Settings 
 

 
 

Sometimes, you might have requirements to create KB articles that deals with non-support issues. You can mark such articles 

as ‘private’ to differentiate it from other KB articles. In Personal Helpdesk > Advanced Options > KB tab, you can specify 

additional options to deal with private KB articles. 

 

 

Do not show private KBs in ‘Reply with KB’ dialog box 

Enable this option to hide private KB articles from appearing in the ‘Reply with KB’ dialog box (to prevent 

technicians from accidentally using private KB articles to reply to emails). 

  

NOTE: ‘Reply with KB’ option button is located under Outlook > Helpdesk toolbar in your Inboxes. 

 

 

 

Do not publish private KBs to Web 

Enable this option to exclude private KB articles from being published to the online KB module of Customer Web 

Service (CWS) site. 
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4.11 Automation Options  
 

With the Automation Options, you can configure the helpdesk system for on-the-fly assignment of due dates on new cases, 

set email processing workflow, add reminders to your calendar – and increase productivity of the helpdesk. 

 
 

 

Due Date for newly created cases 

Specify how the due date of newly created support cases should be assigned. 

 

a) Assign current Date/Time – Choose this option to set the current date/time (e.g., same as when the case was 

created) 

b) Schedule – Choose this option to schedule ahead it. You need to input the number of hours or days that will be 

scheduled ahead for the due date of the new case 

c) Assign the current or next available Working Hour – Choose this option to dynamically seek the next available 

working hour (as per helpdesk availability e.g., starting and closing hours). 

d) None – Choose this option to have empty due date on the new case. 

 

 

Respond by date for newly created cases 

Specify how the respond by date of newly created support cases should be assigned. 

 

a) Assign current Date/Time – Choose this option to set the current date/time (e.g., same as when the case was 

created) 

b) Schedule – Choose this option to schedule ahead it. You need to input the number of hours or days that will be 

scheduled ahead for the due date of the new case 

c) Assign the current or next available Working Hour – Choose this option to dynamically seek the next available 

working hour (as per helpdesk availability e.g., starting and closing hours). 

d) None – Choose this option to have empty due date on the new case. 
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Configure Email post processing workflow 

 

 
 

 

 Once a case is raised from an email using the ‘Convert to Case’ button (Manual conversion), choose if you 

want to move the original email or its copy (from which the support requests were logged from) to the Personal 

Helpdesk Email History folder. If you want to preserve a copy of the support request email in the Inbox 

permanently, choose the first option ‘Leave the original email intact’ so that you and others will continue to have 

access to that email. 

 

 If the case was raised automatically from an incoming email in a monitored Inbox, choose if you want to 

move the original email or its copy (from which the support requests were logged from) to the Personal Helpdesk 

Email History folder. If you want to preserve a copy of the support request email in a subfolder permanently, 

choose the second option ‘Leave a copy of the email under ‘Processed Emails’ subfolder’ so that you and others 

will continue to have access to that email. 

 

 

When the helpdesk add-in encounters an email from the caller (that contains a Case ID in the subject), and if the 

particular case ID does not exist in Personal Helpdesk Ongoing/Resolved Cases folders (say, it was deleted 

permanently, specify the alternative option the helpdesk add-in should do with that particular email. 

 

Choose ‘Generate a new case from the email’ (first option) so that the add-in will ignore the reference of the non-

existent/invalid case ID and instead raise a new case from the email to generate a new case ID. 

 

Choose the second option, to configure the add-in to move the email that contains the invalid Case ID reference to 

the ‘Unprocessed Emails’ subfolder. And you can later on decide what to do and deal with it. Additionally, you can 

also allow the add-in to send an auto alert to you informing about this email with invalid ID. 
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Technicians Workflow 

 

 

 

Enables Personal Helpdesk to add/update an appointment into your mailbox calendar when due date is assigned 

on a support case. Any change in the due date of that case at a later stage will be automatically updated to the 

existing appointment in the mailbox. This appointment is removed when the corresponding case is closed. 

These due date reminder appointments appear in 

summarized form on the main 'Outlook Today' page 

when you start Outlook. This way, you get to know 

which new cases are being raised and need your 

attention. 

In the default calendar, the due date appointments 

appear as any other appointment. The case number 

and the subject of the assigned case in the appointment subject differentiate it from other personal appointments. 

 

When the due date appointments are about to be overdue, Outlook automatically displays reminders popup. This 

way, you are alerted about the pending cases which need priority.  
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 The details of a due date appointment added from Personal Helpdesk to your mailbox calendar: 

• the case number and case subject are available in the appointment' subject 

• the due date of the case is the same as that of the start time and end time of the appointment 

• In the appointment description field, there is a link to the actual case, clicking which would open the case 

from the Personal Helpdesk 'Ongoing cases' folder. 

• The appointment description also informs the technician about the caller, and a summary of the problem  

 

Enabling this option also allows you to lookup your personal calendar so that the you can assign a particular due 

date on which you are available to work on the case. 
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Enables Personal Helpdesk to add/update a task into your mailbox task folder when you assign/change the due 

date on a support case. Any change in the due date of that case at a later stage will be automatically updated to 

the existing task in the mailbox. This task is removed when the corresponding case is closed. 

 

Enables Personal Helpdesk to maintain a schedule calendar in its own folder such that 

all due date of support cases is listed in corresponding calendar (bearing the 

technician's name).  

When due dates are assigned or changed in support cases, appointments are added or 

updated in these calendars. The purpose of this calendar is to allow helpdesk you to 

lookup these calendars for a suitable schedule such that the assignment of due date 

take into the consideration other assignments which may already existed for that 

particular technician. This will help prevent due date clashes and increase efficiency of 

the helpdesk staffs.  

 

Make Mobile as the primary contact number 

Enable this option to force helpdesk add-in to use mobile number of the technician (over phone) when dialing calls 

to technicians from the case form or Personal Helpdesk contact manager panel.  

 

NOTE: This is applicable only if each technician had enabled phone calls with Skype in Outlook > File > Personal 

Helpdesk > Personal Settings > General tab.   
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Other Automation Settings 

 

 

 

Automatically generate a random password for new caller 

If enabled, when a new, first-time caller is encountered, the helpdesk add-in will automatically generate a random 

password for Caller Web Access website for that new caller before adding that caller to the Personal Helpdesk > 

Callers List.   

 

NOTE: The Caller Web Access (CWA) site, which is a part of the Customer Web Service (CWS) site, requires a user 

credential for caller to access their support cases online. You can define this credential (e.g. password) in the 

Personal Helpdesk Callers list dialog.  

 

Automatically add first time caller to callers list 

If enabled, when a new first-time caller seeks support request (when they send an email to support), the helpdesk 

add-in will automatically add it to the list of callers in helpdesk database, for future use. 

 

Automatically add new problem to Problems list 

If enabled, when a new problem category or type (that does not exist in Problems list yet) is entered by the 

technician in the case form in Outlook, the helpdesk add-in will automatically add it to the list of problems in 

helpdesk database, for future use. 

 

Allow color coding of case items based on the status of the case 

If enabled, when you set the status of the case or when the add-in does that automatically using the default status 

values set for various events, you will see that the categories column of the case item has color-coded status 

(which you can define for each status under the column 'Color Code' in Personal Helpdesk > Problems List > 

Statuses List). 
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4.12 Case Options  
 

 

 

Allotment Template for new case  

If you have defined more than one allotment templates, choose a default allotment template that will be set 

automatically on newly raised cases. For more on Allotment Templates, refer to Personal Helpdesk > Templates Manager 

> Allotment Templates. 

 
Problem Category of newly generated case 

Choose a particular problem category from the drop-down list that will be used as default value for Problem Category 

field on newly raised case. To add new problem category, refer to Personal Helpdesk > Problems List > Categories tab. 

 
Problem Type of newly generated case 

Choose a particular problem type from the drop-down list that will be used as default value for Problem Type field on 

newly raised case. To add new problem type, refer to Personal Helpdesk > Problems List. 

 
Status of newly generated case 

Choose a particular status from the drop-down list that will be used as default value for status field on newly raised case. 

To add new statuses, refer to Personal Helpdesk > Statuses List. 

 
Status of Resolved/Completed case 

Choose a particular status from the drop-down list that will be set to a resolved/completed case. 

 
Status of Re-opened case 

Choose a particular status from the drop-down list that will be set to the reopened case. 

 
Status of case on reply send to the caller 

Choose a particular status from the drop-down list that will be set to the case once a reply is successfully send to the 

caller. 
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Status of case on reply received from the caller 

Choose a particular status from the drop-down list that will be set to the case after a reply is received from the caller. 

 
Status of due date lapsed case 

Choose a particular status from the drop-down list that will be set to the case on due date lapsed. 

 
Status of case on SLA breach (on Due time lapse) 

Choose a particular status from the drop-down list that will be set to the case on SLA breach of Due Time. 

 
Status of case on SLA breach (on Response time lapse) 

Choose a particular status from the drop-down list that will be set to the case on SLA breach of Response Time. 

 
Status of newly assigned case 

Choose a particular status from the drop-down list that will be set to the case just after assigning to a technician. 

 
Status of respond by date lapsed case 

Choose a particular status from the drop-down list that will be set to the case on respond date lapse. 

 
SLA for new generated case 

Choose a Service Level Agreement (SLA) value from the drop-down list that will be applied by default on any newly 

generated case. For more on SLA, refer to Personal Helpdesk > Service Level Agreements. 

 
SLA for re-opened case  

Choose a Service Level Agreement (SLA) value from the drop-down list that will be applied to a case on re-opening. For 

more on SLA, refer to Personal Helpdesk > Service Level Agreements. 

 
When a problem type is chosen from the drop-down field in the case form, you can configure if the helpdesk add-in will 

also automatically apply the Service Level Agreements (that is default and associated with the chosen Problem Type) to 

the case. You can choose default technicians and SLA for each problem type under Personal Helpdesk > Problems List. 

 
 

 

 
When a caller is chosen from the drop-down field in the case form, you can configure if the helpdesk add-in will also 

automatically apply the Service Level Agreements and Associated Users (that are default and associated with the chosen 

caller) to the case. You can choose default technicians, SLA and Associated Users for each caller under Personal Helpdesk 

> Callers List. 
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Case ID and Prefix Code 
 

 

 

Reset Case Number count to zero 

This might be useful on certain situations such as when you are finished testing the demo cases, and want to start afresh. 

Note though, this action can’t be undone. 

 
Append Prefix Code in Email Subject 

Enable this option so that the helpdesk add-in will add a prefix code before the case ID (under subject field) of the case or 

to the outgoing emails. You can choose which prefix code to use from one of the following fields: 

• Problem Category Code – You can define prefix code for each category under Personal Helpdesk > Problems List 

> Categories List tab. 

 
 

• Problem Type Code – You can define prefix code for each problem type under Personal Helpdesk > Problems List. 
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• Department Code – You can define prefix code for each department under Personal Helpdesk > Callers List > 

Departments tab. 

 

 
 

• Company Code – You can define prefix code for each company under Personal Helpdesk > Callers List > Company 

tab. 

 

 
 

• Global Code – You can define one global, fixed prefix code that will be used in all cases and email 

communications within the helpdesk. 

 

 

For instance, you can choose ‘Use Problem Category Code’ so that the helpdesk add-in can insert the prefix code of the 

tagged Problem category in the subject of the case and emails.  
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Alternatively, you can also define a global fixed code that would be prefixed in all the cases. By default, adding prefix 

code before the case ID in the subject of the email is disabled. 

What are the benefits? By adding a prefix code to the subject of the case or on outgoing emails, when callers reply back, 

the received emails would contain the same prefix code. And this in turn may aid in quick recognition of the particular 

case, by simply looking at the prefix code.  

 

For instance, if the department code is set as the prefix code, you and other technicians can easily recognize that a 

particular reply belongs to a specific department. Likewise, if the technician code is set as the prefix code, you can easily 

recognize who is responsible for attending to the reply or the case. Moreover, it is easy to differentiate important emails 

from the less trivial ones. 

 

 
 

 

 

 
Insert Case ID and Prefix in the subject of the related original email 

Enable this option so that the helpdesk add-in would embed prefix code and Case ID into the subject of the original email 

just after a case is successfully raised from that email. 
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Don’t process emails with invalid/non-existent prefix code 

When the add-in tries to add/update a possible reply (that contains a number enclosed in square brackets) to its 

corresponding case, enabling this option will skip processing those emails that do not contain a valid prefix code in the 

subject. 

 

 
Change the Case Number counter 

Enables you to alter the current case numbering count to your specified number. Comes handy if you want the case 

numbering to start from a particular number. E.g. 10000 instead of 1 (default). 

 
 

 
Placement of Case ID/Prefix code in subject 

Choose if the prefix/code (enclosed in square brackets) is to be placed at the beginning or end of the subject line. By 

default, the prefix code/ID is placed the beginning of the subject. 
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Consolidated Conversation and Emails Threading 
 

 

Most support cases cannot be closed within a single e-mail and response. Feedback from the caller and suggestions from the 

respective technicians often occur over multiple request-response emails. Moreover, different members from the support teams 

may provide resolutions during the course of the request. So, in practical scenario, a support case might have various e-mail 

versions of the resolution steps, making it cumbersome to get a complete picture of responses and resolution. 

With the conversation threading feature, Personal Helpdesk captures the complete course of the conversation chronologically, 

from all email communications received or sent (including those automated notifications sent to caller and technicians in due 

course). The end result is a consolidated view where all the responses to a support request are collated together. Redundant and 

repeated conversations are filtered out to present only the relevant communications. This eases the task of the helpdesk and 

minimizes repeating what has already been done, while keeping support team members to stay on the track. Another advantage is 

it allows the technician to quickly glimpse through the thread and get a complete overview on the responses in chronological 

order and resolution applied to the particular support request, something which is hard to extract from viewing multiple email 

responses. 

 

Choose if new conversation to the case is to be added on top or below of existing consolidated conversations. 

 
Add header entry in the consolidated conversation for automated notification sent 

Enable this option to embed a snippet entry of the automated notification or alert sent to the caller or technicians by the 

helpdesk add-in. 
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Link Header entry in consolidated conversation to actual mail item 

Enable this option so that the added conversation snippet is hyperlinked to the actual email item (so that it is clickable 

and allows for quick access to the linked email without searching for it). 

 
 

 
Transfer attachments from email reply to case item 

When processing incoming replies (that contains attachments) from caller, enable this option so that the helpdesk add-in 

will also automatically add these attachments from email to the case item. 
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Optionally, you can enable the option ‘Add entries of new attachments in the conversation’, so that a new snippet entry 

on the attachment names (which were added to the case) are included to the conversation. 

 

 
Add notes to consolidated conversation 

Enabling this would add a copy of the private note (that is added from the Notes tab of the case form) to the conversation 

threading (body field), which is then visible even when the case is previewed in Outlook Explorer window when selected. 
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Helpdesk Fields Workflow 

 

 

 

Mandatory fields that are required to be filled out for marking a case as resolved 

Enable this option to set certain helpdesk fields as mandatory to be filled, before the case can be marked resolved or 

complete. And select the fields that are to be made mandatory.  

NOTE: Mandatory fields will be shown in red labels in the case form. 

 
Hide Case form sections/tabs 

You  can choose to hide certain portion of the Outlook case form, such as the Time Spent, Email History, Notes section 

etc. if these sections or tabs won’t be used at all. And this setting would affect all technicians. For example, below is 

how the case form appears when none of the sections/tabs are hidden. 

 

And below is the case form with ‘Related Cases’, ‘Associated users’, ‘Logs’, ‘Notes’ and ‘Related KB Articles’ tabs 

hidden. 

 

 
Limit user from entering their own value in the following drop-down fields 

Check the particular drop-down fields that you only want technicians to be able to choose from the drop-down and 
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prevent entering their own. By default, technicians can input their own value against the available drop-down list. To 

prevent non-existent value from being tagged to the case for these drop-down fields, check the corresponding field. 

 
 

NOTE: drop-down fields with limitation in case form are greyed out, where ones without limitation are not (white 

back-color) 
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Logo and Case Form  

 

 

 

Substitute the logo with your own 

To use your own company logo or brand in the case form, you can specify an image file (JPG, GIF, PNG) located on a 

network shared folder. Or, alternatively, you can use an image file located on the web. 

  
 

And when you open and view the case form in Outlook, your company logo you specified above should show. 

 

NOTE: Make sure you use an image path that is accessible to all technicians from their systems. This means, you can 

either make sure of an image file that is located on a shared network folder (e.g., \\Server\files\logo.gif) or an image from 

the web (e.g., www.company.com/logo.gif) 

 
Data loading behavior in the case form 

By default, helpdesk add-in implements ‘on-demand’ loading of the data in the case form for performance i.e., it will load 

the data for the case section/tab as and when you click and navigate to it. 

 

file://///Server/files/logo.gif
http://www.company.com/logo.gif
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However, with the second option, you can overwrite this workflow to force the helpdesk add-in to load all data 

concurrently at once in all sections and tabs of the case form. Note that, with this approach, the performance might take a 

hit and the case form might take longer time to load and show.  

 
Prompt to add Time Spent when closing the case form 

Enable this option to force the helpdesk add-in to prompt the technician to add their time spent data to the case when 

the form window is closed. 
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Other Case Options 

 

 

 

Automatically update caller information from the case 

form to the Callers List 

 

If enabled, the helpdesk add-in will track the changes in 

the caller information in the cases and if required, will 

make the necessary update back to the Personal 

Helpdesk > Callers List if any of the caller information 

was changed or added in the case. 

 

 

For example, when a caller seeks support request the first time, the helpdesk may only have the caller email and name in 

the callers list database.  

However, after iteration of communication or calls, if the caller information was updated to the case to include say, 

phone number, mobile number, address, company etc., the helpdesk add-in will automatically track and update the 

caller information back to the Callers list database for future use. 
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Include CC users in the notification email sent to the caller when a case is generated from an email 

If enabled, when a support case is first generated from an email, helpdesk add-in will send out the case allotment 

notification email to the caller, as well as to the recipients specified in the CC field of the original email. The benefit is to 

allow anyone (on the CC line) to respond to the ticket thread without creating a new ticket. 

 

 
Automatically view the case that was re-opened in its inspector window 

Enable this option to force helpdesk add-in to display the case in its window when it is re-opened from completed state. 

This is applicable and handy if you had re-opened the cases from the search panel or from the Outlook explorer window. 

 

 

 
 

 
Don't reopen a closed case automatically 

There may be situations where the caller just replied to say, thank you for the support. But that may trigger a reopening 

of the case with unnecessary overhead. Enable this option to prevent the helpdesk add-in from automatically re-opening 



 

 

 Back to TOC 

P
ag

e7
3

 

a case from its completed state when a response from the caller is received by the helpdesk after the completion of the 

case. This will also prevent the add-in from adding redundant and irrelevant information to the closed case. 

NOTE: If enabled, closed cases won’t reopen automatically when a customer sends a reply after the case is closed. This 

way it is very easy to miss the reply of the customer because the case stays in closed issues. Technicians would have to 

manually re-open the case (if they deem fit) after analyzing the response from the caller i.e., if the caller just replied to 

say, ‘Thank you for the support’, you can ignore the escalation. 

 

 
Automatically assign technician associated with the sender's email domain name to the new case 

If enabled, helpdesk add-in will automatically assign default technician to a case based on the sender's domain address 

e.g. sender@somecompany.com 

 

NOTE: You can add company details under Personal Helpdesk > Callers List > Company tab. And add somecompany.com 

in the domain column and also specify default technicians for that company. 

 
By default, check the 'Disable Notifications to caller' option on newly generated cases 

Sometimes, on specific cases or caller, you may want helpdesk add-in not to send auto notifications on activities or 

events of the case. So instead of disabling a particular auto-alert at the global level, you can choose to disable auto-alerts 

on per case. Enable this option so that by default, notifications are turned off to caller for new cases. 

 

 
By default, check the 'Disable Notifications to technicians' option on newly generated cases 

Likewise, on specific cases or technicians, you may want helpdesk add-in not to send auto notifications on activities or 

events of the case. So instead of disabling a particular auto-alert at the global level, you can choose to disable auto-alerts 

on per case. Enable this option so that by default, notifications are turned off to assigned technicians for new cases. 

 

 

 
If a problem type exists in the email subject, automatically assign it and related default values to the new case 

If enabled, the helpdesk add-in will automatically search for the existence of any problem type keyword in the subject of 

emails. If exists, it would auto-assign the default values of the technician, SLA or problem category fields (based on the 

admin enabled fields) to the case that are associated with the particular problem type. 

mailto:sender@somecompany.com
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For example, here is a problem type ‘iPhone’ in the Problems List, which belongs to ‘Mobiles’ category and default 

technician is ‘Aaron Beit’, and default Service level is ‘SLA 3’ and default Zone (custom problem field) is ‘East Zone’. 

 

And assuming a customer sends an email to helpdesk with problem type ’iPhone’ keyword in the subject.  

 

When a case is raised from this email (manually or automatically), the helpdesk add-in will sense the presence of a 

problem type keyword (e.g. iPhone). And it’s intelligent enough to auto assign the default technician and service level 

(SLA) associated with this problem type. This will in turn trigger a notification alert to the assigned technician as well as to 

the supervisors (if the specific alerts are enabled in Personal Helpdesk > Notification Options > General Alerts tab). 
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When importing caller info from GAL, use the value of the address from – Street field or Office location field 

With this feature, when choosing a caller from the address book, you can instruct the add-in which location field of the 

contact in Global Address List (GAL) would be used to populate the Address field of the Caller in the Outlook Case form. 

You can choose the Street field of the contact, or the Office location. Default is the Street field. 

 

 
Show Time Spent in – Minutes or Hours 

You can set helpdesk add-in to display the time spent on a case as minutes or hours. Default is in ‘Minutes’. 

 

If the 'Hours' option is selected, the add-in will display the total time spent on a case in HH:MM format. 

 

 
 

 
Show non-due date appointments when browsing the calendar 

You can look up your personal mailbox calendar for time availability and schedules from within the Outlook case form. By 

default, only the due-date specific appointments in the calendar are visible.  

 

Enable this option to show all appointments (e.g. personal appointments) available to the assigners when the 

technician’s calendar is accessed for schedule availability chart from within the case form.  

 

 
 

NOTE: This feature only works when you enabled 'Automatically add due date appointment into the technician's 

mailbox calendar' in Personal Helpdesk > Automation Options > Technicians tab. 
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4.13. Service Level Agreements (SLA) 
 

A service-level agreement (SLA) is a contract between a service provider such as a company helpdesk and a customer that specifies, 

usually in measurable terms, what services the provider will furnish. It is now widely accepted that service provision and receipt 

should be governed by an agreement. This is essential to define the parameters of the service, for the benefit of both the provider 

and the recipient. More importantly, it should have a guaranteed response or resolution time for incidents (trouble tickets). For 

example, a SLA between Webhosting Company and its customers could be –2 hrs. response time. In Personal Helpdesk, Service Level 

Agreement (SLA) is designed around two dimensions ‘Response Time' and 'Due Time'. 

 

 

 

Response Time -  duration within which the assigned technicians of the case should have responded to the caller for the 

first time (after the case was logged). When a SLA is enforced to a case, the response time of that SLA would be adjusted 

(added) to the 'Respond by Date' field. If the case was not responded within the stipulated SLA response time, a SLA 

breach (i.e., a response time lapse) would occur and an automated notification would be sent to the supervisors.  

 

Due Time - duration within which the assigned technicians should have closed (mark complete) the case. When a SLA is 

enforced to a case, the due time of that SLA would be adjusted (added) to the 'Due Date' field. If the case was not closed 

i.e., mark competed) within the stipulated SLA due time, a SLA breach (i.e., a due time lapse) would occur and an 

automated notification would be sent to the supervisors. 

 

Helpdesk Service Hours – Enables you to specify the service days and hours their helpdesk operates. With this 

mechanism, any automatic assignment of response by date or due date to support cases, including those triggered by an 

enforced Service Level Agreement (SLA), would be dynamically adjusted to fall within the service days and hours. By 

default, service day start from Monday and ends at Saturday. You can choose the service starting and ending days as per 

your helpdesk requirement. 

 

Once a service days and hours are specified, respond by date or due date assignment will take note of the helpdesk 

unavailability accordingly. When specifying a SLA to a support case, the response time or due time would be added to 

the current date/time, plus any helpdesk off-hours such that, the response by date or due date is always set within the 

service hours band. So, no longer you or other technicians would be sent respond by date or due date lapse or SLA 

breach automated alerts in off hours of the helpdesk. 

 

Personal Helpdesk System allows you to set and maintain SLA standards in the organization. Within the Outlook case form, you can 

enforce or change a SLA on a support case based on escalation requirements. Additionally, SLAs can be assigned automatically to 

newly created cases. For example, in Customer Web Service (CWS) website, end-users submitting support request via a webform 

would select a problem category and type along with other information. When the submitted support request is processed in 

Personal Helpdesk in Outlook, the default SLA specified for that combination of Problem Category and Type fields is enforced to the 

case.  

As a support case approaches an SLA Management breach, the case item appears red in the Outlook view, as well as escalation 

alerts, either as email or SMS message are sent out to the concerned technicians and supervisors. This prevents any issue or request 

from ever falling through the cracks and allows your team to effectively stay on top of any support cases approaching the breach of a 

Service Level Agreement. 
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SLA Supervisors 
 

To keep a tap on timely resolution of cases, you can enable notification alerts to supervisors when there is a SLA breach etc. 

 

 

To choose supervisors, click ‘Choose’ button. This will allow you to select users from your address book or GAL. 

 

SLA Calculation 

 

 

 

By default, when a SLA is applied to a case, the helpdesk add-in calculates the ‘respond by date’ field by computing the 

SLA response time to the current date/time. But you can change that so the SLA response time is applied to the request 

received time of the email, or date/time when the case was generated or simply added on top of an existing ‘respond 

by date’ (if it is not empty). 

 

 

By default, when a SLA is applied to a case, the helpdesk add-in calculates the ‘due date’ by computing the SLA due time 

to the current date/time. But you can change that so the SLA due time is applied to the request received time of the 

email, or date/time when the case was generated or simply added on top of an existing ‘due date’ (if it is not empty). 
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4.14 Mobile Messaging 
 

Short Message Service or SMS, is used by billions of people and is the most pervasive use of data on mobile phones. SMS is 

convenient and cost effective for a number of reasons. When compared with the cost of airtime for voice calls or wireless web 

access, SMS is a real bargain and messages are immediately delivered directly to your phone. Personal Helpdesk system 

supports dispatching automating alerts to mobile devices of the callers or technicians in the form of SMS messages. 

 

Personal Helpdesk supports sending SMS messages using two different technologies/platforms - Skype and HTTP SMS 

gateway. 

 
 

 

Allow SMS Messaging 

By default, SMS messaging is disabled in Personal Helpdesk. Check this option to enable SMS messaging for your 

helpdesk. 

 

Default Country Code 

Input the ISD code of your country. For example, for United States, it is 1 and for United Kingdom, it is 44. For more on 

country code, click here. 

 

Use Skype to send SMS 

Sending SMS via Skype is the simplest way of enabling support for SMS messaging functionality in Personal Helpdesk. It is 

cheap, convenient, seems relatively reliable too! Every technician needs to have Skype installed with valid credits to send 

SMS to mobile phones. There are no specific settings that needs to be configured in Skype. The only requirement is that 

it should be running with valid credits. Skype is seamlessly integrated with Personal Helpdesk i.e., the sending of SMS via 

Skype is done programmatically (through Skype API) which means the technician does not perform any manual steps 

during the process. The technicians won't even notice the Skype is being used during the whole process of SMS 

messaging. For more on Skype SMS, visit the Skype website at https://www.skype.com/en/features/sms/. 

 

https://www.immihelp.com/nri/isdcodes/search.do
https://www.skype.com/en/features/sms/
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For the first time, when a technician tries to 

send an SMS (or call) to a mobile or phone 

number, Skype would automatically pop up 

a message asking you if to allow the 

Outlook Application (Outlook.exe) access to 

that Skype functionality. 

 
You will have to select the first option 'Allow this program to use Skype' and then click OK to continue. This 

setting is performed only one-time per user; subsequent access happens seamlessly to the technicians, i.e., Skype 

remembers the selected option and would allow access as long as the user don't explicitly unset it under Skype > 

Tools > Advanced > ‘Manage other programs access to Skype’. 

 

 
 

 

Using an Email SMS Service 

Choose this option if you have an Email to SMS gateway service that allows you to turn your email into a text message 

without any extra effort. All that is needed is to send an email to mobile-number@SMS-SERVICE-DOMAIN.com 

 

For instance, 933332323@someGateway.com where 933332323 is the mobile number to which the SMS will be sent to 

and someGateway.com is the SMS gateways service.] 

 

With this SMS option enabled, Personal Helpdesk add-in would then direct all SMS alerts (if enabled) in the form of 

emails to mobile-number@[SMS-SERVICE-DOMAIN.com] after which the SMS gateway service take over to translate 

email to SMS before delivering it to the mobile number.  

 

mailto:mobile-number@SMS-SERVICE-DOMAIN.com
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Special Code in Email Subject - If your SMS service provider requires a special code in the email subject for recognition or 

authentication purpose, you can input it in the text box (outlined in red above). Doing so, the add-in will put this special 

code in the subject of the email before sending it to the SMS provider account. 

SMS Gateways - If your organization does not have an in-house Email to SMS service, there are plenty of commercial 

Email to SMS service providers on the web. For example, SMS Gateways shown below are for U.S. carriers only. 

SMS Gateways 

Alltel Wireless mobile-number@message.Alltel.com 
mobile-number@text.wireless.alltel.com 

AT&T Wireless mobile-number@txt.att.net 

AT&T Mobility (formerly Cingular) mobile-number@cingularme.com 
mobile-number@mobile.mycingular.com 

Boost Mobile mobile-number@myboostmobile.com 

Cricket mobile-number@sms.mycricket.com 

Metro PCS mobile-number@mymetropcs.com 

Sprint (PCS) mobile-number@messaging.sprintpcs.com 

Sprint (Nextel) mobile-number@page.nextel.com 

U.S. Cellular mobile-number@email.uscc.net 

Verizon mobile-number@vtext.com 

Virgin Mobile mobile-number@vmobl.com 

 

 

Sending SMS to a caller 
Once a SMS option is configured, you then can start sending self-composed SMS to caller based on the helpdesk requirements. For 

instance, from the case form, you can click the ‘SMS’ button (mobile field of the caller) to send a custom message to the caller. 

 

 



 

 

 Back to TOC 

P
ag

e8
1

 

Automating SMS reminders 

Personal Helpdesk can also send out automatic SMSs based on different helpdesk events such as when a case is created, changed or 

resolved, or when a technician is assigned to the case, or when the due date has lapsed etc. This whole exercise is transparent to the 

technicians and needs no manual intervention from the technicians. For more on automatic notifications, refer to Personal Helpdesk 

> Notification Options > General Alerts tab. 
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4.15 Predefined Answers (FAQs) 
 

There might be times when you just need to answer briefly to a frequently asked question from callers. Instead of framing the 

answer over and over again, just imagine how easy it would be if you can compose a predefined answer lists with relevant answer 

categorized by problems. With such a setup, it is very easy to reply to a support request email by just selecting the appropriate 

predefined answer and embedding it to the email. 

You can maintain a list of predefined answers (FAQ) to most asked help desk questions. These answers can then be used to reply to 

frequent asked questions quickly without needing to compose redundant information again and again. Each predefined answer can 

be specified to belong to a problem category and type. This is particular helpful to build an organized library of answers that is easy 

to find in time of need.   

 

 
Frame a new question and answer. 

 
Edit the selected question and answer. 

 
Remove the selected question and answer from the list. 

 
Problem Category for which this question and answer belongs to. You can choose a category from the drop-down list. To 

add or modify categories, refer to Personal Helpdesk > Problems List > Categories tab. 

 
Problem type for which this question and answer belongs to. You can choose a type from the drop-down list. To add or 

modify types, refer to Personal Helpdesk > Problems List tab. 

 
Frame your question here. 

 
Click to edit the existing question. This will allow you to modify the existing question in an input box prompt. 

 
The detailed answer of the question that address an issue related to the problem category or type. A WYSIWYG editor is 

available to help you format the content of your answer. You can change the font, style, paragraph etc. 
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4.16 Automatic Email Monitoring 
 

Many organizations believe e-mail is a highly efficient way to have their customers submit service and support requests. Your 

customer types in the problem, presses send, and within seconds, it is in support mailbox of your helpdesk account. But the reality is 

that nothing happens until someone reads it, creates a support case from it (this usually involves cutting and pasting from the e-

mail), and assigns it to an engineer or technician for resolution. Because there is both manual labor and personal attention involved, 

the process can result in delays, support requests falling into the cracks, errors in transcription, and unhappy clients. And 

unfortunately, this can become a barrier in the helpdesk main goal, which is to provide timely response to the caller. This is a 

nightmare scenario for helpdesk team. 

Fortunately, this is easily avoided in Personal Helpdesk System. As it is integrated seamlessly with your Outlook email client, there is 

no requirement to cut and paste information from the email to the support case. Even better, there is no need to manually process 

each email. You can configure Personal Helpdesk System to monitor any number of mailboxes and email folders (such as public 

folders) such that it can intercept incoming emails and automatically generate support cases out of the emails, all instantly i.e., as 

and when emails hit the inbox. With this kind of setup, you are freed from having to monitor inboxes manually every now and then. 

The generated support cases are then stored under the exchange folder making it available to all members of your team for 

collaboration. Any file attachments will be automatically attached to the problem case (Outlook item); making distribution of 

inbound requests simple and informative. This way, all support submissions are captured and centralized in order to execute 

efficient and effective customer service. 

 

 

Choose a mailbox account or email folder (such as an Exchange folder or Public Folder) from which Personal Helpdesk 

add-in will raise new cases from incoming emails automatically. 

 
Once a mailbox account or email folder is chosen, click ‘Confirm and Add’ to the list for automation. 

 
The folder or mailbox that has been chosen for automation. 

 
Select a particular problem category from the drop-down list that will be set to the new case as default value for 

‘Problem Category’ field. 
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Select a particular problem type from the drop-down list that will be set to the new case as default value for ‘Problem 

Type’ field. 

 
Select a suitable service level (SLA) from the drop-down list that will be set to the new case as default value for ‘Service 

Level’ field. 

 
Enable or disable the case automation workflow for the particular mailbox account or email folder. You may want to 

disable the automation process temporarily on a particular mailbox or folder if for instance, a maintenance or migration 

is planned. 

 
The 'Action Mode' consists of 3 possible values: New, Update and Both. 

A) If ‘New’ option is selected, Personal Helpdesk will automatically raise new support cases from new incoming emails 

from the particular monitored mailbox or folder. With this option, only those emails without the case ID in the subject 

would be processed to generate new cases. Those with Case ID info in the subject will remain unprocessed. 

B) If ‘Update‘ option is selected, Personal Helpdesk will only process new incoming emails that have the case ID in the 

subject and accordingly, it will update the associated case item (in the Ongoing Cases or Resolved Cases folders). Emails 

without the Case ID information in the subject will remain untouched. This is handy if the mailbox or folder contains or 

receives emails that are unrelated to the helpdesk. 

C) If ‘Both’ option is selected, Personal Helpdesk will update the existing cases as well as generated new tickets from new 

incoming emails (depending on the availability of the Case ID in the subject of the email). This is the default selected 

option when you add a new mailbox or folder for automation. 

 
You can specify a different auto-response to caller for cases raised from each monitored mailbox. For instance, if 

someone sends an e-mail to UK.Support@myCompany.com, you would want to inform the customer that their e-mail 

will be responded to within 2 hours between 9am and 5:30pm UK time. If they send a new case to 

US.Support@myCompany.com, you can inform the customer that their e-mail will be responded to within 3 hours 

between 9am and 5:30pm Eastern Standard Time. 

 
Enable this option to enforce service level that are associated to the problem type of the monitored folder to the newly 

generated cases 

 
Check this option to automatically convert incoming emails in 'Ongoing Cases' folder to support cases. For this feature to 

work, the 'Ongoing Cases' folder needs to mail-enabled. You can also drag and drop emails from other folders to the 

‘Ongoing Cases’ folder and the add-in will automatically process and convert those emails to cases. 
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4.17 Web Access 
 

To allow general customers (end-users) to submit online support requests, Personal Helpdesk provides them an easy web interface 

accessible through a web browser on the internet. For this feature, the web access files are placed under a new virtual directory in 

your IIS server with appropriate permission over the web folder.  

The Customer Web Service (or CWS which we will refer to often in this manual) is an AJAX enabled ASP.NET 2.0 website. For detail 

information on how to install, configure and use CWS, refer to section 23. Customer Web Service 

 

 

Here, you need to specify the shared network path of the CWS folder (which is located in your IIS C:\inetpub\wwwroot 

parent folder on your windows server). To save/update the CWS specific XML metadata files from Outlook to the shared 

network web-enabled folder (on the server), it needs to know the full UNC folder path. If the network folder resource 

requires a network credential, then you will be prompted to enter one. 

 NOTE: You need to share this CWS folder such that all technicians can have access to it from their respective systems 

within the office network.  

 
Automatically update CWS metadata XML files (including web.config) 

Enable this option to allow helpdesk add-in to update the CWS specific settings metadata automatically when there is 

any change in the Personal Helpdesk settings. The Personal Helpdesk lists and settings (e.g. problem categories and 

types) would surely change/update in due time. You would need to update the web service XML metadata files 

accordingly, so that data used in the web service application is in synch with that in Outlook. Though the you can 

manually update the data files for web service, it would be a tedious task if the settings in Outlook are to change every 

now and then. In such scenario, it is recommended to allow helpdesk add-in to automatically update CWS specific 

metadata XML files in the shared network folder, when there are any changes in the lists and settings in Outlook. 

 
Update Knowledge base data XML files 

Check this option to publish or update knowledge base data XML files in the web-enabled CWS network folder. 

 
Make the Time Spent accessible to Caller Web Access (CWA)  
Enable this option so that when callers are logon to the Caller Web Access site, they can see the time spent details 

entered by technicians in the cases allotted to them. 
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Make Email History accessible to Caller Web Access 

Enable this option so that when callers are logon to the Caller Web Access site, they can see the Email communication 

history between them and the helpdesk in the cases allotted to them. 

 
Make private notes accessible to Caller Web Access 

Enable this option so that when callers are logon to the Caller Web Access site, they can see private notes entered by 

technicians in the cases allotted to them. 

 
Web URL of CWS site 

Enter the full web friendly URL (e.g. http://www.yourcompany.com/CWS/) that is accessible by your customers from the 

Internet or Intranet. What you entered here will be available for embedding into email template (i.e., Placeholder 

variable SCO_WEBACCESS_URL) which would be then sent to the customer after a case is raised from their support 

request email or call. 

 
Enter the confirmation information from the helpdesk to be displayed in the webpage of CWS when a new case is 

submitted successfully by a customer through the webform. 

*Caller Web Access (CWA) - is a part of the Customer Web Service (CWS) site, requires a user credential for caller to access their support cases online. You can 

define this credential (e.g. password) in the Personal Helpdesk Callers list dialog. Alternatively, a random password can be generated automatically when a new 

caller is added to the Callers list.  

 

  

http://www.yourcompany.com/CWS/
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4.18 Personal Settings 

 

 

 

Allow Phone Calls 

Personal Helpdesk has built-in support for making phone calls either using Skype or attached phone to callers, technicians 

or contacts in your address book. Each technician can choose either one of these techniques. 

Skype can be used to make internet phone calls (VoIP) with a valid Skype account. The international call charges are 

reasonably prices and make sense if you have a good internet bandwidth for a quality voice over calls. Only Skype version 

2.5 and above are supported. More on making calls with Skype 

 
Default Time 

You can specify a default time (in minutes or hours) that would be initially set as the default value for the time spent when 

you try to add one in the case form in Outlook. 

 

 

 

 

 

  

  



 

 

 Back to TOC 

P
ag

e8
8

 

Incoming Email Tracking 

 

 

 
Automatically track incoming replies and update the associated Support case 

Enable this option for the incoming replies from callers to be automatically added and updated to the corresponding case. 

The agent add-in will then track and monitor the chosen mailbox for any incoming emails that are related to existing 

cases. And if one is found, it will be automatically added and updated to its corresponding case item. 

By default, Personal Helpdesk Agent add-in only tracks and processes the emails associated with existing cases from your 

primary mailbox. So, if you receive emails from callers to other mailboxes in your Outlook, then you must specify those 

mailboxes too. Enabling this would force your Personal Helpdesk Agent add-in to look for incoming emails in those 

mailboxes too. 

NOTE: If there are no Inboxes shown for selection above, the most probable reason is that, the email accounts configured 

in your Outlook may be of non-exchange account type like POP3, IMAP and others. In order to automatically track your 

incoming email in your account, the account type should be exchange type. 

 
Enable this option so that the add-in (after processing the replies automatically) can move the email replies (to existing 

case) from the original location (e.g., your Inbox) to the Personal Helpdesk History folder. 

 

NOTE: Leaving a copy of the emails in your Inbox allows for quick access. And it makes it easier to reply to the issue too 

from your Inbox. And the add-in will continue to track the response you send to the caller irrespective of the reply being 

done from your Inbox or from the case form. 

 
Enable this option to force the add-in to scan for any unprocessed replies (that has a ID in the subject) in your Inbox 

during Outlook startup and automatically update the new replies to their associated cases. This is useful in situation 

where the helpdesk add-in was disabled temporarily, leading to email replies to existing cases not being processed. And 

once the add-in is enabled, it can scan the existing emails for any unprocessed emails. 

You can specify the number of days old the add-in will scan for unprocessed emails. 
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Outgoing Email Tracking 

 

 

 
Automatically track outgoing replies and update the associated Support case 

Enable this option so that responses to the caller from the helpdesk are automatically added and updated to the 

corresponding case. The agent add-in will then track and monitor the chosen mailbox for any outgoing emails that were 

sent to the caller. And if one is found, it will be automatically added and updated to its corresponding case item. 

By default, Personal Helpdesk Agent add-in only tracks and processes the responses to callers associated with existing 

cases from your primary mailbox. So, if you use other accounts to reply to cases, then you must specify those mailboxes 

too. Enabling this would force your Personal Helpdesk Agent add-in to look for outgoing emails in those mailboxes too. 

NOTE: If there are no ‘Sent Items’ folders shown for selection above, the most probable reason is that, the email accounts 

configured in your Outlook are of non-exchange account type like POP3, IMAP and others. In order to automatically track 

your outgoing emails in your account, the account type should be exchange type. 

 
Enable this option so that the add-in (after processing the responses automatically) can move the email (to existing case) 

from the original location (e.g., Sent Items folder) to the Personal Helpdesk History folder. 
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User Interface 

 

 

 
Placement of toolbars in Outlook- With these options, you can control the placement of the helpdesk toolbars in Outlook 

explorer and inspector windows. You can also choose to place the helpdesk toolbar to a dedicated tab. 

 
Show helpdesk context menu on top - Enable this option to show the helpdesk context menu in topmost position when 

you right-click any case or email items in Outlook. By default, the helpdesk menus are shown in bottom position. When 

this option is enabled, the helpdesk menu items appear at higher position in the context menu (right-click menu). 
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If the option is unchecked, the helpdesk menu items appear at the lowest position in the context menu. 

 

 

 
Placement of preview case form – Choose a layout that you would like the preview case to be placed in the Ongoing Cases 

and Resolved Cases folders – left, right, top or bottom of the reading pane. 

 
Enable this to hide the ‘Case Summary’ tab in case preview form.  

 
Enable this to hide the ‘Emails’ tab in the case preview form. 

 
Enable this to hide the ‘Notes’ tab in the case preview form. 

 
Enable this to hide the ‘Related Cases’ tab in the case preview form. 

 
Choose a language that will be used in all the Personal Helpdesk UI in Outlook. The following languages are supported:  

English, Español, Norwegian, Danish, Dutch, Deutsch, French, Finnish, Swedish, Portuguese 

NOTE: When you switch to any language and save it, the chosen language will be applied to the next session of Outlook. 

Therefore, you are required to restart your Outlook for the new language to be affected to all forms, panels and UI of the 

add-in in Outlook. 
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5. Working with Personal Helpdesk folders   
Once you have installed Personal Helpdesk, you will find that there are a 

couple of subfolders in the main parent folder. Each folder serves a specific 

purpose and the very name reflects the kind of items it holds. 

You can of course change the subfolder name to anything that you want it 

to be and it would not break the working of the Personal Helpdesk System. 

 

5.1 Ongoing Cases Folder 
 

This is the most prominent folder where you will be working the most! As the name implies, this folder stores all the ongoing 

cases and, most probably would be most visited and used Personal Helpdesk folder. Any new case, either created manually or 

generated from out of an email would be stored here, waiting to be attended. A dedicated Outlook ribbon toolbar is used to 

house various drop-downs options and buttons related to these folder items. And items in this folder are stored with the 

message class 'IPM.Post.PHO.CASE'. This folder also comes with Helpdesk specific Outlook views of around 30 or more. 

 

 

Settings menu – contains shortcuts to all 

administrative panels and tools. 

 

 
 

 
Create a new empty support request case. 

 
Mark the selected cases as resolved (closed). Cases marked resolved are then moved to the 'Resolved Cases' folder. 
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Delete the selected cases from the folder. If the deleted case has any email replies, they will be also deleted. 

 
Sometimes, a caller might contact you through separate emails or channels regarding a particular issue. The same issue 

might be logged as a case by a different agent not knowing an existing one already exists. To avoid duplication and 

conflicts, you can merge all related cases together and keep the communication streamlined. The merge action is 

irreversible, and causes the following things to happen: 

a) One of the cases becomes the primary case (you get to choose).  

b) All conversations from the secondary tickets are moved into the primary case.  

c) All messages are sorted chronologically.  

 
Print the selected cases using the customizable 'Print HTML’ template. 

 
Create knowledge base items out of the selected cases. 

 
Search the 'Ongoing Cases' folder for items (support cases) with keywords. The searched result is effectively applied to 

the Outlook folder view (by means of Outlook filtering) which would result in only displaying those support cases that 

meet the searched criteria. Click the 'Clear' button to clear the search in the folder view (and revert back to the selected 

view effectively). 

 
Show/toggle the advanced search options - Apart from the free text search by keywords, Personal Helpdesk also 

implements an advanced search and reporting options with an array of filters available to extract only the required 

support cases quickly within the folder view itself. 

 
The 'Ongoing Cases' specific Outlook views are the primary interface with which most technicians will scan through for 

relevant cases in this folder. The drop-down menu lists all the available views for this particular folder. Each view is 

organized to group and filter support cases to make a particular feature of your information obvious at first glance. 

 
The folder view listing all support cases grouped and sorted as per the current selected view (e.g. Technicians - Table). 

Each group also shows the number of items it holds as well as number of items that are unread. Selecting anyone of the 

case item displays the problem description in the Outlook preview pane. 

 
The Outlook preview pane displaying the problem description of the selected case item. It also displays a Personal 

Helpdesk specific form region on the right side of the preview pane. This ‘Case Preview’ form shows all the available 

helpdesk meta fields including custom fields and the values these hold when you select or highlight any Outlook case 

item in the Ongoing Cases or Resolved Cases folders.  

 

Through the case preview form, see all the related emails of that case directly or reply or forward or send a KB quickly 

without opening the case item in its Outlook inspector window. You can also see the private notes that are added by 

other technicians. 
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5.2 Resolved Cases folder 
 

This is pretty much similar to the 'Ongoing Cases' folder in term of structure, custom form and contents. The difference is the 

message class and that cases in this folder are marked complete and are not available for direct edit, i.e., the case form will only be 

available in read-only mode. To work on a resolved case, it would first have to be re-opened (which will then move the case to the 

'Ongoing Cases' folder). The message class used for cases of this folder is 'IPM.Post.PHO.CASE'. Most of the Helpdesk Outlook views 

in this folder are similar to the 'Ongoing Cases' folder except for some specific views that are specific for resolved cases. 

 

 

 

Re-open the selected resolved cases by marking the items as 'Ongoing'. Re-Open cases are then moved to the 'Ongoing 

Cases' folder. 

 
Create knowledge base items out of the selected cases. 

 
With the Archive cases tool, you can archive old support cases periodically to a local PST file that are older than a certain 

(user-selected) date. This is an important maintenance step that would improve the efficiency of the Personal Helpdesk 

System (as well as for Exchange storage). 

 

 
Sometimes, a caller might contact you through separate emails or channels regarding a particular issue. The same issue 

might be logged as a case by a different agent not knowing an existing one already exists. To avoid duplication and 

conflicts, you can merge all related cases together and keep the communication streamlined. 

The merge action is irreversible, and causes the following things to happen: 

a) One of the cases becomes the primary case (you get to choose).  

b) All conversations from the secondary tickets are moved into the primary case.  

All messages are sorted chronologically. 

 
Print the selected cases using the customizable 'Print HTML' template. 

 
Delete the selected cases from the folder. If the deleted case has any email replies, they will be also deleted. 

 
The 'Resolved Cases' specific Outlook views are the primary interface with which most technicians will scan through for 

relevant cases in this folder. The drop-down menu lists all the available views for this particular folder. Each view is 

organized to group and filter support cases to make a particular feature of your information obvious at first glance. 
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5.3 KB folder 
 

This subfolder houses a complete knowledge base system inside your Outlook and is closely integrated with the Personal Helpdesk 

help desk. The KB articles are available for inserting into email replies, on cases and even appointments and tasks. An Outlook 

toolbar option is also shown and has buttons to create a new empty knowledge base, forward it to an email address or publish the 

whole knowledge base on the world wide web (AJAX website). Any default posting to this folder would take the custom form with 

message class 'IPM.Post.PHO.KB’. 

 

  

 

Create a new empty knowledge base item 

 
Forward the selected knowledge base item to a contact 

 
Export the KB to file such as PDF or Word document. 

 
This drop-down menu lists all the available views for this particular folder. Each view is organized to group and filter KB 

articles to make a particular feature of your information obvious at first glance. 

 

 
A Question and Answer format is used to intuitively display Knowledge Base Articles. Each Article may have any number 

of file attachments associated, rich-text elements, and hyperlinks to other web pages. All articles are tagged with a 

related problem category and problem type. This enables the articles to be grouped by category and type in the KB folder 

view making it easier to find a particular article at time of needs. 

 

 
The Outlook preview pane (if enabled) displays a preview of the description field of the selected knowledge base item. 
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5.4 History Ongoing and History Resolved folders 
 

These subfolders store all of the originating emails and subsequent replies from the caller. That is, emails associated with an ongoing 

case are stored in the History Ongoing folder. Likewise, emails associated with a resolved case are stored under the ‘History 

Resolved’ folder.  

When you open a support case, there is a tab ‘Emails’ and it lists all the replies in chronological order that were received from that 

caller.  

Each of this history folder includes a custom Personal Helpdesk view (as shown below) that group email replies from caller based on 

case number. 
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5.5 Schedules folder  
 

This is an optional folder that Personal Helpdesk will use if you decide to maintain your due date schedule for cases. The idea is to 

enable you to check for availability for a particular time slot before a due date can be assigned to finish the case.  

 

A calendar (having the same name yours) within this folder will be maintained. Whenever a 

new due date is assigned or an existing one is changed, it would be reflected in the calendar 

as well. If a case is closed (marked complete), the corresponding due date from that calendar 

is removed. 

When due dates are assigned or changed in support cases, appointments are added or 

updated in these calendars. The purpose of these calendar is to allow you to lookup these 

calendars for a suitable schedule such that the assignment of due date take into the 

consideration other assignments which may already existed. This will help prevent due date 

clashes and increase efficiency of the helpdesk. 
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6. Working with the Personal Helpdesk UI 
As Personal Helpdesk is seamlessly integrated into Microsoft Outlook, you will find many new interfaces specific to Personal 

Helpdesk in the form of toolbars, drop-down menus, and ribbons, forms, context menus etc. plugged in to the usual Outlook 

explorer and inspector windows. These make it considerably easy to create support request from emails, send SMS, and make call or 

import contacts. 

 

6.1 The Settings menu 
 

The Personal Helpdesk Client menu provides a central place for technicians to access to frequently used helpdesk operations. 

 

Administration 

Panel 

Consists of list managers, automation options, 

templates editor etc. Learn more 

 

Contact Manager Launch the contact manager dialog to quick scan 

through Personal Helpdesk internal list of callers and 

technicians and make a contact (email, SMS, or a call). 

Learn more 

  

Search cases Launch the advanced search manager dialog to query 

for both ongoing and resolved cases without needing 

to open the respective folders. Learn more 

 

Statistics Check which technicians are online at the current time with 

Personal Helpdesk client system running in their Outlook. 

Also tells the version number of Personal Helpdesk Client 

installed on the technician’s system. Learn more 

 

Summary Reports Launch the reports tool. Learn more 

 

Archive Cases Launch the archive tool to move old resolved cases to 

another PST or folder location. Learn more 

 

Reset Connection Shortcuts to Personal Helpdesk folders in single-click 
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6.2 Ribbon Toolbars 

 
Personal Helpdesk displays a toolbar on the Outlook explorer window depending on the items content of the current active folder. 

This enables Personal Helpdesk to target functionality specific to each Outlook item such as mails, posts, appointments, tasks and 

contacts. 

 

On Contact folder. 

 

Context Menu 
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7. Working with Support Case form in Outlook 
The support request form in Outlook is especially designed to log in new case and view existing ones in the Outlook folder. 

Information catering to the case, caller, problems etc. are laid out in a very intuitive way. 

 

 
 

There are various sections in the form such as time spent, email history, notes, assets, custom fields and related cases that 

technicians can easily navigate and work upon. Contact fields are accompanied by relevant buttons for making quick 

correspondence to the contact such as email, phone calls or simply sending SMS. Fields such as problem category, type, status 

and department are available in drop down format so as to limit the choice the technician can select for such fields.  

 

When setting due date of the case, you can choose to lookup for an appropriate schedule in your calendar (can be personal or 

a public calendar). Automatic notification messages (either via email or SMS) are sent out immediately to you once the case is 

assigned or a due date is specified or changed. Optionally, a due date appointment or task can also be added to your personal 

mailbox as reminders. 

 

From directly in the case form, you can quickly browse, preview and select a knowledge base article or predefined reply and 

insert a relevant solution directly to the case problem description or make a quick reply to the caller. When logging in a new 

phone case, an existing caller, either from the caller list or from global address list (GAL) can be selected and it will 

automatically populate all other available caller fields such as address, phone number, company etc. 
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7.1 Case Detail 
The first section of the support request case form consists of fields related to caller, problems, due date etc. There are also 

numerous buttons at the end of the fields such as email address, phone, etc., for quick communication. 

 

 

The unique number (referred to as case number) generated for this particular support request. Personal Helpdesk uses 

an iterative count to generate new support requests. Every email communications out of Support to the callers are 

tagged with the corresponding case number such that subsequent email replies from the callers retain the same tag for 

Personal Helpdesk to identify and perform various automations like adding the replies to the particular support case. 

Internal communications to technicians in the form emails, SMS, due-date appointments, tasks etc. are also tagged with 

the corresponding case number. 

 
The date/time the support request (usually an email) was first received in Inbox. 

 
The date/time the support request was logged, either from Outlook items such as email or phone call. 

The support staff (or technician) take was responsible for logging this support request. Note that, the assigned technician 

need not be the author of this case. 

 
The date/time the support request was last worked on. 

 
The date/time the first response to the caller was made (by a technician) after this case was raised. 

 
Shows the duration (in days) the support case is active. 

 
A drop-down field that consists of the problem category list. Specify the problem category to which the support request 

belongs to. 

 
A drop-down field that consists of a type list (sub-category) for each problem category. The type list changes depending 

on the item selected in the problem category drop down field. 
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Problem Category-Type: Apply default SLA - This check button gets enabled when a combination of Problem Category 

and Problem Type is selected from the drop-downs. Checking this button would automatically enforce the default SLA 

specified for that selected problem to the current support case. Both the importance and the due date of the case would 

be then affected. 

 
This is a dependency drop down field that is tied or associated with a problem type. The name of this field is 

customizable and by default it is named as ‘Problem Field’. In this above example, it is named as ‘Zone’. You can 

customize its name; its drop down lists as well as its association with the problem list this under Personal Helpdesk > 

Problems List panel > Problem Field tab (last tab usually). 

 

 
This is a drop-down field that consists of the problem status list (customizable by technicians with admin access). 

 
The origin field signifies the source from which this case was raised from. 

 
This is the same Outlook importance field that takes one of these values - High, Normal and Low. 

 
Choose an ‘Allotment Template’ that will be used for this particular case. The chosen allotment template will be then 

used send notification alert to the caller when a case is raised. For instance, if someone sends an e-mail to 

UK.Support@myCompany.com, you would want to inform the customer that their e-mail will be responded to within 2 

hours between 9am and 5:30pm UK time. If they send a new case to US.Support@myCompany.com, you can inform the 

customer that their e-mail will be responded to within 3 hours between 9am and 5:30pm Eastern Standard Time. You can 

define different auto-response allotments under Personal Helpdesk > Templates Manager > Allotment Templates. 

 
Callers List – Choose a caller from the Callers List maintained under Personal Helpdesk settings database for this case. 

You can maintain a list of callers under Personal Helpdesk > Callers List panel. 

 
Allows you to pick a user from the address book (e.g. global address list). For new (empty) support request, a technician 

can easily pick a contact from the address book (e.g. GAL) and that populates any additional caller details automatically. 

 
The email address of the caller. This drop-down field houses all the email address of the callers defined in the Callers list 

manager. This is useful when the technician had to manually log a new support request case, say when caller is on the 

phone. Selecting an email address automatically populates other fields such as caller name, address, phone etc.; thereby 

reducing time spent trying to log every single detail on the caller. 

Open a new email populated with details on the support request (as defined in configurable email template) addressed to 

the caller. A new compose window will be loaded on which further inputs can be made before sending it. 

Directly send an email to the caller containing details (as defined in configurable email template) on the support request.  

The email is sent directly with no window displayed to edit or add any comments. 

 
Caller: Apply default SLA - This check button gets enabled when a caller email address is selected from the drop-downs. 

Checking this button would automatically assign the default SLA (specified for that selected caller) to the current support 

case. 

 
First and Last Name – First name and Last Name of the caller. 

 
The full name of the caller. For new (empty) support request, a technician can easily pick a contact from the address 

book (e.g. GAL) and that populates all other caller details automatically. 
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 Allows the technician to pick a user from the address book (e.g. global address list) 

 
The telephone number of the caller. If the caller exists in the Personal Helpdesk Callers list, a telephone number can be 

specified and it automatically gets listed in this field. If the caller has been picked from the address book (e.g. GAL, AD), 

this field would also get populated (provided the primary telephone of the picked user is specified in GAL or AD). 

 Call the telephone number of the caller 

 
The mobile number of the caller. If the caller exists in the Personal Helpdesk Callers list, a mobile number can be 

specified and it automatically get listed in this field. If the caller has been picked from the address book (e.g. GAL, AD), 

this field would also get populated (provided the mobile number of the picked user is specified in GAL or AD). 

 Call the telephone number of the caller 

 Send a SMS message to the mobile device of the caller 

 
The internal department/category to which the caller is assigned to. This field also gets populated automatically if the 

caller exists in the Personal Helpdesk Callers list or in the address book (e.g. GAL, AD). 

 

 
The full correspondence address of the caller. This field also gets populated automatically when caller is specified from 

the Personal Helpdesk Callers list or picked from the address book. 

 

 
The organization/company to which the caller works for. This field gets populated automatically when caller is 

specified from the Personal Helpdesk Callers list or picked from the address book. 

 

 
The technician who is assigned to this support request case. This would of course be you (all the time). 

 Add/update the due date appointment to the mailbox calendar of the selected technicians. If successful, it 

automatically triggers a reminder popup on that technician as well as get added to Outlook today page. 

 Add/update the support request task to the mailbox task folder of the selected technicians. If successful, it 

automatically triggers a reminder popup on that technician as well as get added to Outlook today page. 

 

 
A drop-down field listing all defined Service Level Agreements (SLA) of the organization. When a SLA is enforced to a 

support case, the importance of this Outlook item is automatically set to that defined by the SLA as well as the due date 

is adjusted to reflect the response time of that SLA under which the case should be resolved. 

 
Respond by date - duration within which the assigned technicians of the case should have responded to the caller for the 

first time (after the case was logged).  

You can set an initial response time by manually specifying one after the case was raised, or a default date/time could be 

set under Personal Helpdesk > Automation Options > New Case tab. 

Additionally, when a service level (SLA) is enforced to a case, the 'Response by Date' field is adjusted automatically with 

the response time of the applied Service level. 

 reset the respond by date to none. 

 
The due date field enables you to set a time before which the support request case should be resolved. There are lot of 

automatic notifications and reminders options that can be sent to concerned technicians when a new due date is 

specified or updated. For example, when a new technician is assigned, Personal Helpdesk can send out notification email 

or SMS informing technicians on the due date of the support request. Personal Helpdesk can also automatically 

add/update a due date appointment or task to the personal mailbox calendar of the concerned technician. 

When deciding to set a due date for a particular support request case, you can look up the schedule calendar/personal 

calendar of a prospective technician in order to find availability of the said technician. 

 reset the due date to none. 



 

 

 Back to TOC 

P
ag

e1
0

4
 

 lookup the schedule calendar of the assigned technician to see workload and availability of the technician on a 

particular duration. 

 
 

 
This is the ‘Custom Fields’ section. If your helpdesk requires to collect more in-house information on the case, you can 

add any number of additional fields from Personal Helpdesk Add-in > Custom Fields panel. All the deployed custom 

fields would be then available in the case form for input. 
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7.2 Emails 
The Emails section shows all email correspondences received from the caller or sent to the caller on a support case. The emails are 

ordered chronologically with the newer emails at the top listing. Notice that each email item listed has a Personal Helpdesk case 

number tagged to the subject for tracking and identification.  

 

NOTE: Emails shown in this section are stored in the History subfolder located within the parent Personal Helpdesk folder. For 

instance, emails associated with an ongoing case are stored under the ‘History Ongoing’ subfolder, whereas those associated with a 

resolved case are stored under the ‘History Resolved’ subfolder. 

 

 

Open and view the selected email in its own (separate) inspector window of Outlook. 

 
Delete the selected emails permanently. 

 
Arrange the email preview pane side by side with the emails list pane (vertical positioning). 

 
Arrange the email preview pane to locate at the bottom of the emails list pane (horizontal positioning). 

 
Make a reply to the selected email. 

 
Make a reply from the selected email to the caller as well as to all the recipients in the CC field (if any). 

 
Forward the selected email to another user. 

 
Reply the selected email with a chosen snippet of the frequently asked question (or predefined answer). 

 
Reply the selected email with the content of a chosen knowledge base article (KB) including any attachments and images. 

 
The preview pane showing the contents of the selected email. This gives you direct accessibility to the emails without 

requiring you to open them in their separate inspector windows. To open an email in its native Outlook inspector 

window, double-click the email entry in the list pane. 
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7.3 Time Spent 
 

The Time Spent section lists all work sessions performed on the support case. This time spent field can be made optional or 

mandatory before marking the case as closed. By default, it is optional. Also, to calculate cost of supporting the case in statistics, 

Personal Helpdesk needs to have a valid work time. 

 

 

List of all time spent entries logged to the case when working to resolve it. Apart from the time spent value (either in 

minutes or hours), each record in the list shows the technician name who made the entry, the date and time etc. 

 
Shows the total time spent (either in minutes or hours) made so far on this particular case. 

 
Enter a new time spent value to the case. A pop up dialog allows you to enter a duration (in minutes or hours), as well as 

description of the work done.  

 

 

You can also enter a start and end time so that the duration is automatically calculated. 
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Edit an existing time spent entry. You can also modify the time spent value and description. The technician and time 

stamp are however, read-only. 

 

 
Remove the selected time spent entries from the case.  

NOTE: you need to save the case in order for the removed entries to be permanently reflected to the case. 

 

 

  



 

 

 Back to TOC 

P
ag

e1
0

8
 

7.4 Assets 
The assets section in the support case provides fields for all of your organization's hardware and software inventory. An asset may 

be cataloged and categorized by Asset Types. All the asset fields except for the asset name can re-titled to adapt and take any of 

your organization’s intrinsic properties of inventories such as Make, I.P. Address or OS information; providing invaluable information 

directly from trouble case. 

 

 
List of assets related to the problem reported by the caller. 

 
This drop down contains all the assets of the organization (can be defined under Personal Helpdesk add-in > Assets List). 

To add and associate this case with an asset, choose it from the drop down and click ‘Add’ button. 

 
Click to add the chosen asset to the case. The reported problem (as tagged in the case) can be linked to multiple assets. 

 
If you don’t remember the asset name 

(true if your organization has 

hundreds to thousands of them), you 

can make a keyword search. 

 
 

 
Remove the selected assets from the list (and delink them from the case). 
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Show the list of cases that have the same asset. To open a specific case, select it and either click ‘View’ button located 

just above the list, or double-click the case. 

 
Open the selected case in its own case form (inspector window). 

 
Choose whether to show related for ongoing cases or resolved cases or for both. 

 
Asset Information tab shows you the inner fields and data of the selected asset. The captions of these asset fields are 

customizable to meet the requirement and nature of your inventories with the Personal Helpdesk add-in. 

 
Save any changes made to the asset fields back to the case. 

 
This tab shows any additional fields you might have added and deployed (for the purpose of collecting more information 

on the asset). This fields can be added and customized from Personal Helpdesk add-in > Assets Fields > Additional 

Fields. 

 

Associating problems and incidences with actual hardware and software inventory is crucial to maintaining proper preventative 

incident management and finding the core problem to repetitive issue or problem that is plaguing a large group of end-users. 

Personal Helpdesk provides a means for the technician (in Outlook and web) or the customer (via web form) to create this hard-link 

between a troubled asset and a case. 
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7.5 Related Cases 
 

The ‘Related Cases’ tab lists all the ongoing and resolved cases logged for that particular caller, or department or company or email 

domain so the responsible technicians can have a panoramic view of all past problems history.  

 

 

Choose a filter (caller, department, company or domain name) that will be used to show related cases. 

 
Choose if to only display the related cases that are ongoing, resolved or both. 

 
Open the selected case in its own case form (e.g., inspector window). Alternatively, you can double-click 

the case entry to open it. 

 
Merge the selected cases to one single case. Sometimes, a caller might contact you through separate 

emails or channels regarding a particular issue. The same issue might be logged as a case by a different 

agent not knowing an existing one already exists. To avoid duplication and conflicts, you can merge all 

related cases together and keep the communication streamlined. 

The merge action is irreversible, and causes the following things to happen: 

a) One of the cases becomes the primary case (you get to choose).  

b) All conversations from the secondary tickets are moved into the primary case.  

 

 

  



 

 

 Back to TOC 

P
ag

e1
1

1
 

7.6 Associated Users 
 

Often a helpdesk may have the requirement to link certain stakeholders, apart from the caller, to a support case. Such users can be 

external vendors, contractors or secondary field technicians that are related to resolving the case, though might not be direct 

support technicians of the helpdesk.  

 

In Personal Helpdesk, we have added a feature to associate any contacts from your Address Book (or Global Address List - GAL) to a 

particular case item, such that these associated users would receive a copy of the caller or technician specific automated 

notifications. Refer to Personal Helpdesk add-in > Notification Options > Associated Users Alerts. 

 

 

List of all associated users that are stakeholders to this case. 

 
Make a reply to the selected user. A new reply window in Outlook will pop up and the body of the email will be derived 

from the ‘Email to Caller’ template (customizable under Personal Helpdesk add-in > Templates Manager > General 

Alerts tab). 

 
Make a reply to all the users in the list. 

 
Manually add a new user to the list by entering the name and email address. 

 

 
Add a new user to the list by choosing it from the address book or global address list. 

 
Remove the selected users from the list (and de-associate from the case) 
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7.7 Logs 
 

The log grid lists all the important correspondence logs such as emails, SMS, calls made from the support case to the caller or 

technicians. Each log entry has a small description field, the date/time of the action as well as the technician who is working on it. 

 

 

 

  



 

 

 Back to TOC 

P
ag

e1
1

3
 

7.8 Notes 
 

The notes section enables you to add private notes to the support case for internal use. 

 

 

Enter the new note that you would like to add to this case. 

 
Click to add the new note to the existing notes of this case. Each note that is added to the case bears a 

header title that has the technician name and the date and time the note was added. 

 
Existing notes of this case. Each note is separated by an empty line. 
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7.9 Related KB articles 
 

This section will show all the KB articles that are associated with the problem category/type information of the particular case. This 

provides you an easier way of finding a relevant KB article that has the solution/fix to the caller's issue. And when such a KB article is 

found, you can quickly email it to the caller (as inline content or as PDF or XPS attachments). 

 

 

Shows the list of KB articles available on the same problem category and type. For example, as the current case is tagged 

to ‘Notebooks’ category and ‘MacBook’ type, the number of KB articles that filed under this category and type are shown 

so that you can confine your search for a possible clue or answer to the issue on a smaller subset of articles. 

 

 
Open the selected KB article in its own KB form inspector window (of Outlook). Alternatively, you can double-click that 

particular KB article to open in its own form/inspector window. 

 
Arrange the KB preview pane side by side with the KBs list pane (vertical positioning).  

 
Arrange the KB preview pane to locate at the bottom of the KBs list pane (horizontal positioning). 

 
Make a reply to the caller of this case with the content of the currently selected and previewed KB article. 

 
The preview of the selected KB article. 
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8. Common Tasks 
You can also perform various other tasks in the support request form - print, reply to the caller with a knowledge base or a 

predefined answer, publish the case to files or to a knowledge base, mark support request as resolved etc. 

 

 
Directly reply to last email received from the caller. You can also forward the last email received on that case. 

When you click the 'Reply’ button in the case form, it will make a reply to the last email that was received from the caller 

or sent to the caller, without actually searching and clicking the previous email. This feature would greatly improve the 

helpdesk productivity and decrease the number of clicks (without this, you would have to find that particular email from 

the communication chain, and once found, you will need to double-click to open it and click reply). 

 
Selective disabling of auto alerts to callers or technicians - Sometimes, on specific cases or caller or assigned technicians, 

you may want Personal Helpdesk not to send auto notifications on activities or events of the case. So instead of disabling 

a particular auto-alert at the global level, you can choose to disable auto-alerts on per case. Simply check the options 

'Disable Notifications to Caller' or 'Disable Notifications to Technicians' from the particular case form. 

You can also set Personal Helpdesk to automatically check both these options on newly raised cases from Personal 

Helpdesk > Case Options > Other Options tab. 

 

  

 
With these two buttons, you can choose the layout of the case form -  either in tabs view or in Single Page view (or also 

known as List View).  
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In tabs view, you will find multiple sections or tab that shows information on the case selectively. One needs to navigate 

its way to the desired section to uncover the information beneath. This view is best used to reduce cluttered-ness and 

information overload. 

 

 
In the Single Page view, all the tabs/sections of the case form are merged to present a continuous flow of information in 

the same page.  

 

Each section or tab is separated by a gray horizontal bar header. Clicking the bar hides or shows the information beneath 

the section. In this view, all the sections may not fit within the available screen area, but with the aid of the vertical scroll 

bar, you can navigate down to see the rest of the sections. 

At any time, you can switch the case view to tabs or single page. And the add-in remembers your choice of View when 

you open another case the next time. 

 
Enable 'edit mode' for the problem description field. By default, the HTML description field is locked. 

 
Mark the current support request as complete. This closes the case and is moved to the 'Resolved cases' folder. 

Notification about closed case is sent to caller, if enabled. 

 
Save any changes made to the form. 

 
Save any changes made to the form and exit the inspector window. 

 
Generate a new knowledge base out of the current support request case. The generated knowledge base will be stored 

under the 'KB' folder. 



 

 

 Back to TOC 

P
ag

e1
1

7
 

 
New ID – Click this to assign a new case number. This would allow you to assign the next available case number through a 

popup window.  

 

Click the button ‘Generate next available number’. After clicking the button ‘Generate next available number’ a new case 

number will be generated. 

 

To confirm the new case number, Click the ‘Confirm’ Button. Your existing case is now assigned with a new case number. 

 
Print the current case using a template. 

 
Other Options menu  

 

Insert KB to Conversation - Select a KB item and insert into the problem description field. A dialog pops up and 

allows you to browse through the available KBs by problem category and type. 

 

Insert FAQ to Conversation - Select a predefined answer and insert into the problem description field. A dialog pops up 

and allows you to browse through the available predefined answers by problem category and type. 

Cancel Case - At times, you may accidentally have raised a new case from an email, and you may want the opportunity to 

cancel that case. 

 

 

 

 

 



 

 

 Back to TOC 

P
ag

e1
1

8
 

 
Added two buttons to place the case form in left or right side of the inspector window of the opened item. 
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9. Case Preview Form 
'Case Preview' form shows all the available helpdesk fields including custom fields. Additionally, you can now see all the emails 

related to that case directly in the preview form. And you can reply or forward or send a KB directly without opening the case form. 

 

There are four (4) panels in the preview form 

 

The Case Summary tab shows all the available helpdesk meta fields including custom fields and the values these hold 

when you select or highlight any Outlook case item in the Ongoing Cases or Resolved Cases folders. These fields are 

listed under 10 groups - Analysis, General Information, Callers Information, Problem Information, Service Level, Time 

Spent, Custom Fields, Asset Fields, Additional Information and Logs. 
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If the selected case is ongoing, you would be able to mark it complete. If the case is resolved, you would 

be able to reopen it. 

 
Choose a service level to enforce to this selected case. 

 

 
Enter a new time spent value to this selected case. 

 

 
Choose or enter associated users that have a stake to this selected case. 
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Choose one or more assets (that are related to the issues reported by the caller) and associate it to the 

selected case. 

 

  

 

In the Emails tab, you can see all the related emails of that case (including emails received from the caller and sent to 

the caller from the helpdesk).  You can reply or forward an email to the caller or send a KB quickly without opening 

the Outlook inspector window.  

 

 

Quickly reply to the last email - This will make a reply to the last email that was received from the caller or 

sent to the caller.  

 
Make a reply to the selected email. 

 
Make a reply from the selected email to the caller as well as to all the recipients in the CC field (if any). 

 
Forward the selected email to another user. 

 
Delete the selected emails permanently. 

 
Reply the selected email with a chosen snippet of the frequently asked question (or predefined answer). 

 
Reply the selected email with the content of a chosen knowledge base article (KB) including any 

attachments and images. 
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In the Notes tab, you can see the private notes that are added by you.  

 

 

Enter the new note that you would like to add to the currently selected case. 

 
Click to add the new note to the existing notes of the selected case. Each note that is added to the case 

bears a header title that has the technician name and the date and time the note was added. 

 
Existing notes of the selected case. Each note is separated by an empty line. 

 
 

 

The ‘Related Cases’ tab lists all the ongoing and resolved cases logged for that particular caller, or department or 

company or email domain so the responsible technicians can have a panoramic view of all past problems history. 

 

 

Choose a filter that will be used to show related cases based on the caller, department, company or 

domain name. 

 
Choose if to only display the related cases that are ongoing, resolved or both. 
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10. Conversation threading 
Most support requests cannot be closed within a single e-mail and response. Feedback from the caller and suggestions from other 

stakeholders often occur over multiple request-response emails. Moreover, different members from the support teams may provide 

resolutions during the course of the request. In practical scenario, a support case might have various e-mail versions of the 

resolution steps, making it cumbersome to get a complete picture of responses and resolution.  

With the conversation threading feature, Personal Helpdesk captures the complete course of the conversation chronologically, from 

all email communications received or sent (including those automated notifications sent to caller and technicians in due course). The 

end result is a consolidated view where all the responses to a support request are collated together. Redundant and repeated 

conversations are filtered out to present only the relevant communications.  

 

This eases the task of the helpdesk and minimizes repeating what has already been done, while keeping you to stay on the track. 

Another advantage is it allows you to quickly glimpse through the thread and get a complete overview on the responses in 

chronological order and resolution applied to the particular support request, something which is hard to extract from viewing 

multiple email responses. 
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11. Raise a new empty case 
Sometimes you might need to raise new case based on the issue reported by your caller through phone calls. In such situation, you 

can press the ‘New Case’ button located in the helpdesk toolbar to raise a new empty case and feed the information including the 

issue description into the form. 

 

Within the empty case form, the first step you typically would like to start is by entering a short summary in the subject to enable for 

quick identification and then describe the issue in detail in the body field. You can insert supporting files as attachments (similar to 

how you attach a file when composing an email in Outlook). 

 

 
Enter a brief summary of the issue reported by the caller on the phone in the subject field. 

 
Enter detail description of the issue on the body field. 

 
Feed the caller name, email address, phone number, company etc. into the caller information section of the case form. 

Once the required details are entered into the form, either press ‘ID’ button or the ‘Save’ button would generate and assign a new 

ID to the case. You can then provide this ID to your caller on the phone. Additionally, the add-in will also automatically send a 

confirmation email alert to the caller. 
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12. Raise a new case from an email manually 
Support cases can be generated from diverse source such as incoming emails, appointments, tasks, phone calls or web forms and are 

available instantly to all members of the helpdesk team via Outlook or web browser.  

 

12.1 Convert email, appointment or task item to a case 
 

In your Inbox or calendar or task folder, select that particular email, appointment or task item and press 'Convert to case' located in 

the helpdesk toolbar to raise a new support case.  

  

This new case will be created under the ‘Ongoing Cases’ folder. You can then add further details (such as the classification of 

problems the request falls into) to the case form. 

 



 

 

 Back to TOC 

P
ag

e1
2

6
 

12.2 Raising a new case after sending the initial lead/contact to the caller 
 

Sometimes, the helpdesk team may need to initiate or start a case without a request received directly from a user. For example, you 

send a user the serial number for a software they have purchased not because of a request they sent in. So, typically, in such 

scenario, you are initiating the communication by sending them an e-mail that says “Your key is xxxxxxx and here is a link to the 

software”. At the same time, you want a case to be opened based on that email sent to them. 

To accomplish this, a check option 'New Case' is provided in the compose window of the email. So, when you check this option, and 

press 'Send' button, the email will be sent successfully to the caller/contact. At the same time, Personal Helpdesk will raise a new 

case based on that email, with populating the caller details and the description of the problem/email. 

 

A new case is raised based on that email sent to the caller/contact. 
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13. Add an email to a case 
If you want to add an email to an existing case, click ‘Add to existing case’ button available in the helpdesk toolbar in your Inbox. 

This is useful if the caller emails the helpdesk multiple times on different threads but on the same issue or case. You can manually 

add such related emails to an existing case in a click. 

 

'Add to Existing case' is available in two variants:  

 

Through Search - The selected emails will be added to the chosen case in the search panel. If you don't know the case ID 

to which you want to update the emails to, use this method to search for cases that meet certain criteria and from which 

you can choose one quickly. 

 

 
Through ID - If you already know the Case ID to add the selected emails, you can enter it to update quickly. 
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14. Add replies to associated case 
If the emails from the caller already has a case ID embedded in the subject, you can press ‘Add to Case #’ button and the add-in will 

accordingly update the case with no further input required from you.  

 

Instead of manually updating the case with replies to existing case from callers, you can automate this process so that the agent add-

in will selectively monitor incoming emails and only process those replies that have embedded case ID in the subject and 

subsequently updates the associated cases. You can enable this automation from Outlook > File > Personal Helpdesk > Personal 

Settings > Email Tracking – Incoming tab. 

 

 
By default, the add-in only tracks and processes the emails associated with existing cases from your primary mailbox. However, if 

you receive emails from callers to other mailboxes in your Outlook, then you must specify those mailboxes too. Enabling this would 

force your Personal Helpdesk Agent add-in to look for incoming/outgoing emails in those mailboxes too. 
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15. Remove link to case from an email 
This button will be visible when you select any email that has a case ID (with or without Prefix code) in the subject. Clicking it will 

remove the references of the case from that email. You can then raise a new case from that email. 
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16. Using Predefined Answers (FAQs) to reply emails 
There might be times when you just need to answer briefly to a frequently asked question from callers. Instead of framing the 

answer over and over again, just imagine how easy it would be if you can compose a predefined answer lists with relevant answer 

categorized by problems. With such a setup, it is very easy to reply to a support request email by just selecting the appropriate 

predefined answer and embedding it to the email.  

 

The predefined answers list is most prominently used in the outlook case form.  

  

When launched, the predefined answers dialog box 

displays questions which are arranged and grouped in a 

hierarchical tree (e.g. problem categories and types) 

allowing you to select an answer and reply to the caller.  

And the chosen answer (FAQ) is then inserted to a new 

reply, ready for dispatch to the recipient (e.g., caller of 

the case). 
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The predefined answers can also be used to select an appropriate answer and reply directly to emails (outside of Personal Helpdesk 

folders) say in your Inboxes. In fact, they are available in appointments, tasks as well. 
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17. Knowledge Base 
The inbuilt knowledge base in Personal Helpdesk allows you and your team to document best practices and solutions to common 

problems so that they can be used when replying to time-consuming and repeated queries. Any support case is eligible to become 

flagged as a KB Article.  When you recognize a repetitive support issue, you can easily flag a resolved case as a knowledge article. 

Thus, it acts as an effective knowledge sharing medium, boosting support productivity by leveraging collective knowledge and 

providing invaluable KB Articles to support techs in a snap! It also helps in improving the average ‘First Call Resolution’ timing 

significantly, one can find resolution to problems quickly.  

 

Knowledge base items in the KB folder are arranged in hierarchical tree (by group KB items into 'Problem Category' and then to 

'Problem Type'). This arrangement makes it very easy to browse for a particular knowledge base at the time of need. 

 

17.1 Outlook Knowledge base form 
Understanding the Outlook knowledge base form 

It is very easy to use the knowledge base in Outlook. A Question and Answer format is used to intuitively display Knowledge Base 

Articles. Each Article may have any number of file attachments associated, rich-text elements, and hyperlinks to other web pages. All 

articles are tagged with a related problem category and problem type, so it is easy to find a particular resolution at time of needs. 

 

 
The unique ID that is assigned to the KB article. 
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Displays the date and time the knowledge base item was created.  

 
Displays the date and time the knowledge base item was last modified. 

 
Drop down list of all available problem categories defined in Personal Helpdesk problems list. You can select a value from 

the list to mark the category to which the current knowledge base item belongs to. 

 
Drop down list of all available problem types (sub-categories) of the selected problem category. When you select from 

the problem category drop down, another tier of problem type lists will be loaded in the type drop-down control. These 

nested tiers of categories/types are complete customizable to your organization's business model and act as somewhat 

of a guiding decision tree when you search for a particular knowledge base item in the folder. 

 
Check this option to set the KB article as 'private'. Private KB articles can be set to not publish to the online KB module of 

Customer Web Service (CWS) site. Further, you can also set Personal Helpdesk to hide the private KB articles from 

showing up in the 'Reply with a KB' dialog panel. You can control these options from 'Personal Helpdesk Add-in > 

Advanced Options > KB' tab. 

 

 
Click this button to edit/revise the description content of the knowledge base. By default, once a knowledge base article 

is created, subsequent accessing displays the KB in read-only mode. 

 
Click this button to forward the current knowledge base item (including attachments) to a contact. 

 
Click this button to save any changes made to the current knowledge base and close the inspector window. 

 
Click this to save any changes made to the KB article (without exiting the window). 

 
Place the KB form on the left side of the window. 

 
Place the KB form on the right side of the window. 

 
the subject (or a question or a summary) of the current knowledge base. 

 
The description field of knowledge base item. It may have any number of file attachments, HTML formatting, and 

hyperlinks to other web pages etc. You can use the default Outlook formatting tools (such as bold, font, fore color etc.) 

on this field. 
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17.2 Creating a new knowledge base 
 

An empty knowledge base can be created directly from the KB folder, in which case, it would have to be fed manually. A knowledge 

base can also be generated from an existing Outlook item such as email, task or appointment. Generated knowledge base item will 

then inherit the email body (and its format) as well as any number of attachments. Youwould then tag with a problem category and 

one of the types available for that selected category. 

To create an empty KB article from scratch, click ‘New KB’ button located in the helpdesk toolbar of the KB folder. 

 

To create a KB article using the contents of an existing email, click ‘Create KB’ button located in the helpdesk toolbar in your Inbox. 

 

And then choose the category and type to which the new KB belongs to and save it. A new ID will be generated and assigned. It is 

then available for reference by other technicians as well as for replying to recurring issues reported by your callers. 
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17.3 How to use the knowledge base 
 

A knowledge base solution can be used for replying to emails, support case or for embedding into an appointment/task or for simply 

forwarding it to an Outlook contact. A dialog window allows the technicians to browse through the existing knowledge base items, 

even preview it before it can be chosen for embedding into the particular Outlook item (email, appointment, task, support case etc.) 

Steps to embed a knowledge base to a new email, appointment, task or a support case. 

Select an outlook item (email in the screenshot below) and click the 'Reply with a KB' button to display the KB selection dialog. 

 

A pop-up dialog box allows you to browse through the existing knowledge base articles, and select the relevant article to be 

embedded either as Word, PDF or XPS attachment or as inline content into the email reply. 

 

Browse through the listed KBs by problem type and category. Click a KB subject from the tree view to preview the content. Finally, 

when you have found the appropriate knowledge base item, select 'Insert'.  
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The listing of all non-private KB articles available for references. KB articles are presented in tree-view layout with 

problem categories as parent nodes and problem types as child nodes. And KB articles are then shown, grouped by 

category and type.  

 
The preview pane - Choose a KB article and click to preview its content in the preview pane located below or right 

(depending on the chosen layout). 

 
If you have hundreds and thousands of KB articles, finding the relevant and right articles could be tricky. For ease, you 

can search the KB articles with a keyword to find all matching KB articles that contain the keywords. KB articles that 

matches the search will have light red background color for easy reference.  

 

 
Place the preview pane of the chosen KB article to the right (side by side layout) 

 
Place the preview pane of the chosen KB article to the bottom (top to bottom layout) 

 
You can embed the selected KB article directly into the body of the email reply. Any inline images and formatting are 

preserved in its original state in the reply also. 

 

You can also choose to insert as attachment in the form of a word document (*.doc), Adobe PDF (*.pdf), Microsoft XPS 

(*.xps) or as single file MHTML (*.mht). 

 

Additionally, you can also customize the attachment name of the PDF or Word document such as naming the attached KB 

article file with the ID of the KB, or with the subject summary or a combination of both. 
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Check this option to directly send out the reply to the recipient without showing the compose window of the reply. 

 
Once a KB article is found that resolves the issue as reported by the caller, choose it from the tree structure and click 

‘Insert’ to continue. 
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18. Search Cases  
So, you have a repository of support request cases stored in your exchange folders. As the number of logged cases multiplies, 

finding the right information at the time of need is crucial for helpdesk team. For example, more so then often, technicians 

would require querying information based on particular cases, assets, callers etc. Personal Helpdesk supports a 

comprehensive search capability with rich filter sets including full text search on case description body, or on predefined drop-

down lists such as caller, technician, department etc. 

 

 

 

Time Period: Choose a time period from the followings under which the search will be confined: 

Any 

Today 

Yesterday 

Tomorrow 

This week 

Last Week 

Next Week 

This Month 

Last Month 

Next Month 

This Year 

Last Year 

Date Range... 

On 
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Report Type: Choose a report type from the predefined ones below:  

Any 

Cases Created 

Cases Resolved 

Cases Ongoing 

Cases Worked 

Cases Due 

Cases Response Date 

Cases unassigned 

Cases lapsed - Due Time 

Cases lapsed - Response Time 

Cases with SLA Breach - Due Date 

Cases with SLA Breach - Response Date 

Cases with no Due Date 

Cases with no Response Date 

Cases with no Service Level 

Cases with no Caller 

  

 
Search By: Further refine the search by filtering through keywords or using one of the following helpdesk fields - 

Technicians, Status, Problem, Service level, Caller, Department, Company, Priority, Origin, Assets or Author. 

 

 
Group By: You can choose to group the cases either with - Technicians, Status, Problem Category, Problem Type, Service 

level, Caller, Department, Company, Priority, Origin, Assets or Author.  

 
Fields: You are free to choose which particular 

helpdesk fields/columns show up in the search 

result and report. Just click the 'Fields' button, 

and choose the wanted columns to include. 

The tool will remember your choice in 

subsequent runs. You can re-arrange the 

columns by drag-and-drop to get the kind of 

view you want. And the display order of the 

columns will be retained in subsequent 

sessions. 

 

 
 

 
Scope: Choose if to confine the search to your assigned cases only or include all cases. 
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Reply: Compose and send a reply email to the caller of the selected case.  

 
Reply with a KB: Choose a KB article and embed it to a reply email to the caller. 

 
Edit: Open the selected case in its inspector window in Outlook for viewing or further editing. 

 
Mark Complete / Re-Open: If the selected case is ongoing, you can click this button to mark it complete. And if it a 

resolved case, you can click to re-open it, 

 
Delete: Permanently remove the selected cases from the Personal Helpdesk folders 

 
Export to PDF: Click this to export the selected cases to PDF document files. You can also export to Word Documents, 

HTML, plain text etc. 

 

 
 

Multiple cases can be batch exported. Just select multiple cases from the list and choose one of the document type to 

export to, and the batch wizard will perform the rest. 

 

 
 

You can control what case data are included in the files by customizing the 'Print' template under Personal Helpdesk > 

Templates Manager. For example, place the variable 'SCO_CASEDESCRIPTION' in the Print template such that the 

exported file (e.g. pdf) contains all the consolidated conversations (body) from the case item including inline images. 

 

 Print: Click this to print the selected cases using the 'Print' template (as defined under Personal Helpdesk > 

Templates Manager). If you select a single case to print, it will show you the print dialog option, where you can 

customize the layout, paper size etc. However, if you choose multiple cases, it will print directly using the default 

settings without displaying any ‘Print’ options. 
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19. Helpdesk Summary Reports  
Helpdesk summary reports play a vital role in keeping informed you about recent cases - that were created, worked, overdue 

or resolved. Personal Helpdesk provides an inbuilt tool that generates reports on support cases based on a specified interval 

such as today, this week, this month, last month etc. Any fields can be selected for inclusion into the reports and can be saved 

as to file or printed for sharing and easy distribution. 

 

There are four report view modes - List, HTML, HTML Editable and Grid. Noticed that this report tool also uses the same sets 

of search filters discussed in the last section. 

 

 
 

Each case in the search result is color coded to reflect the current status of the case. You can easily recognize which cases 

require the attention or review, and plan actions accordingly. 
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Time Period: Choose a time period from the followings under which the search will be confined: 

Any, Today, Yesterday, Tomorrow, This week, Last Week, Next Week, This Month, Last Month, Next Month, This 

Year, Last Year, Date Range, On 

 

The option 'Date Range…' allows for user selection of start and end date. 

 
 

 

 
 

Report Type: Choose a report type from the predefined ones below: 

Any, Cases Created, Cases Resolved, Cases Ongoing, Cases Worked, Cases Due, Cases Response Date, Cases 

unassigned, Cases lapsed - Due Time, Cases lapsed - Response Time, Cases with SLA Breach - Due Date, Cases with 

SLA Breach - Response Date, Cases with no Due Date, Cases with no Response Date, Cases with no Service Level, 

Cases with no Caller 

 

 
Search By: Further refine the search by filtering through keywords or using one of the following helpdesk fields: 

Status, Problem, Service level, Caller, Department, Company, Priority, Origin, Assets or Author. 

 

 
Group By: You can choose to group the cases either with:  Technicians, Status, Problem Category, Problem Type, 

Service level, Caller, Department, Company, Priority, Origin, Assets or Author. 

 

 
Fields: For finer control over the output of 

report, you can choose which fields (including 

custom fields and calculated fields) are to be 

included in the report.  

You can sort the items by clicking at the column 

headers, as well as also re-arrange the columns 

in the list view according to certain sequence of 

your choice, and even set the width of the 

columns. These formatting from the List view 

panel will be inherited on other tabs - HTML, 

editable HTML and Grids. 

The tool will remember your choice in 

subsequent runs. You can re-arrange the 

columns by drag-and-drop to get the kind of 

view you want. And the display order of the 

columns will be retained in subsequent 

sessions. 

 

 
 

 

Some useful calculated fields that you can include in the report: 
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• Raise Duration - interval between when the support request (email or phone call) was received and when 

the case was raised. 

• Response Duration - interval between when the support request was received (email or phone call) and 

when the first response was made to the caller (by a technician) 

• Open Duration - interval between when the case was raised and the current time. 

• Resolution Duration - interval between when the case was raised and when it was closed/completed. 

• Breach Duration - interval between when the case was due and when it was actually closed/completed. 

 

 
Scope: Choose if to confine the search to your assigned cases only or include all cases. 

 

 
Print the current report - When you click ‘Print’, you would be presented with the print dialog (similar to one used 

by Internet Explorer browser). Within that dialog, you would be able to customize the print settings. Note that, as 

there are multiple report modes (namely, list, HTML, Grid), the printed report will be sourced from the current 

mode (tab) that you are in. 

 

 
Save the current report to file – Once you get the look and feel of your report, you can then export the report to 

one of the many popular document formats supported such as Microsoft Excel sheets, Word documents, Adobe 

PDF, Rich Text or web page etc. 

 

 

 
List report view mode – This acts like a template to the other three report modes. For finer control over the 

output of report, you can choose which fields (including custom fields) are to be included in the report. You can 

sort the cases by clicking at the column headers, as well as also re-arrange the columns in the list view according 

to certain sequence of your choice, and even set the width of the columns. These formatting from the List view 

panel will be inherited on other tabs - HTML, editable HTML and Grids.  

 

 
 

 
HTML report view mode – This report view presents the cases in web HTML format with color coding, group, and 

summary information retained. You can export this report to .htm format for your further use. 
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HTML Editable report view mode – This report view is exactly the same as the previous HTML mode, but with the 

flexibility to edit the HTML content in a WYSIWYG editor. For instance, you can customize the font, add image, 

change the color, layout or add any further information you require so that you can compile your own report. 

 

 
 

 
The Grid report view mode – This presents the cases in excel spreadsheet like format with rows and columns, 

preserving color codes, summarized information etc. You can also re-edit and tweak the report. You can also copy 
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data from this grid to Microsoft Excel or vice versa. And you can of course export the report as Excel spreadsheet 

file (in XLXS, XLS format). 
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20. Helpdesk OLAP Statistics and Reporting 
 

With the integrated Online Line Analytical Processing (OLAP) tool, you can analyze the support request data in 

multidimensional view and extract mission critical information and intelligence that will enable better decision- in your 

helpdesk and organization. The tool supports the ability to explore large complex data sets and allows displaying in grids, 

charts and graphs and support most common operations such as pivoting, drill down/slice and dice, filtering etc. With such 

arrays of information, the organization can reengineer their help desk processes, reinforce resources and forecast problem 

areas and exploit all these factors for competitive advantage. 

 

Why OLAP? Real strength of OLAP is its ability to examine and view data in ways not ordinarily possible. By allowing varying 

levels of granularity during data inspection and visualization a lot of information can be revealed that would otherwise be 

hard to attain. Given that most business models are constrained by more than three dimensions, it is hard to fully evaluate a 

business without the ability to inspect each dimension in detail while preserving context eliminating all guesswork. OLAP is 

perfectly suited for this purpose. Now it’s easier than ever to spot new trends and discover unknown problems in your data 

flow. The statistical tool will help you gain an insight into your data and make new discoveries. Comes with various inbuilt 

reports specific to Personal Helpdesk Cases. 

 

Reporting made easier - The statistical tool's simplistic point-and-click interface will ensure you easily achieve the high-level 

views of information they require. Additionally, the OLAP client makes creating reports destined for different management 

levels a simple task – eliminating your dependence on IT personnel. By unifying data analysis needs on a single platform, it 

provides an unparalleled array of reporting tools for web portals, intranet applications, websites, and other data-rich 

applications. 

 

Printing capabilities - you can print your report to share it with others using the built-in ‘Print Preview’ window. You can tune 

your page/printer settings before printing. Also, if you feel like sharing the report through the net or by email you can easy 

export it to a wide range of formats including PDF, XLS, CSV, JPG, etc. 

 

Copy to Clipboard - Select any data range in Chart/Grid and copy to clipboard. Then you’ll be able to paste it in an Office 

program for further analysis. You can also paste the chart like a picture to illustrate your investigations. This greatly simplifies 

the task of creating detailed, data-rich documents. 

 

Save Reports in file - At any stage, you can save the report and distribute it to another person for analysis by network or 

email, so when the recipient gets the file he can open it and see the same OLAP slice. 

 

Launching the statistics tool: 

 

Go to Outlook > File > Personal Helpdesk 

tab, and click ‘Statistics’ button. 

 

 
 

 



 

 

 Back to TOC 

P
ag

e1
4

7
 

You can choose what type of OLAP statistics on helpdesk data you would like to see and report on. You can specify if the 

statistics would be confined to ongoing cases or resolved cases or on both. You can further have the choice to include 

archived old cases that were moved to another exchange folder or PST file. 

 

 
 

There are two parts of OLAP Statistics 

 

 

General OLAP 

Choose this OLAP to run statistics on cases with all helpdesk parameters and fields except for time spent by 

technicians on cases. 

 

 

Time Spent OLAP 

Choose this OLAP to run statistics on time spent entries by technicians on cases. 
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20.1 The User Interface 

 
The statistical tool presents an easy-to-use interface for operating an OLAP-slice. The basic data is displayed in the Working 

area. The environment tools for managing the content and characteristics of the slice are placed on the pivot panels. You can 

set the panels' layout the way you like. To drag a panel to a different location, you need to capture and drag its header with 

the mouse. At that, all the possible locations, where it can be dropped to, will be highlighted. You can detach a panel from the 

component; it will be displayed as a float window. 

 

 
 

Instrumental panels can be: 

• Attached to any side of the component;  

• Placed into any existing panel;  

• Displayed as bookmarks on any panel;  

• Set as auto-hidden panels;  

• Used as float windows. 

You can change the view of the slice by relocating measures and hierarchies within the environment panel. When you start 

dragging an element, all the possible locations, where it can be dropped to, will be highlighted. Most elements have context 

menus that duplicate the mouse actions and provide additional control functions for managing the slices' view. 

 

 

The File menu 

The file menu consists of the following commands: 
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a) Open Offline Cube from file - While generating a live cube from Outlook always provides the advantage of 

analyzing live data, often, you might be away or disconnected from the network. 
 
In such scenario, you have the option of connecting to an offline cube, which was previously generated and 
saved to your local folder using this utility. An offline cube file has the extension - .offlinecube and can be 
either in compressed or uncompressed format. An offline cube gives the same functionality as that of a live 
cube (which is generated from the Outlook data at real time), except that the data in the offline cube is only 
current to the time the cube was saved to file. This provides the flexibility to continue analyzing the cube 
and writing reports etc, while you are on the move. 
 

b) Open a Predefined View - Pre-defined reports are available under Assets, Cases, Callers, Date/Time, 
Problems, and Technicians nodes. Clicking one of child node report loads the statistical analysis of that 
report, the resultant of which will be displayed in the Grid or Chart (depending on the current active view). 
 

 
 

c) Load report file from Favorite – You can customize or create your own views and save them to the favorite. 
Once saved, your views would be saved under the ‘C:\Users\USERNAME\Documents\Personal Helpdesk 
Reports\Views’ folder (in windows Vista and 7). For windows XP, it should under My Documents. When you 
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open the favorite from this menu, you can choose to load your saved view. 
 

 
 

d) Open report view from file - Once a particular snapshot of the statistics is achieved, you may want to save it 
for future reference or share it among your team members. A report view is the current state of the 
statistics in the Grid/Chart working area, with specific member fields on the pivot panels (Rows and Column 
areas) and measure fields in the values area. It has a file extension ‘.olapreport’. 
 

 
 

e) Save report view to favorite – You can save the current view of the statistics (grid or chart) to the favorite, 
by specifying a name of the view. 
 

 
 

f) Save report view as - If you want to share a report view with others, you can simply save the current report 
(state of the statistics along with the pivot details) to a file folder of your choice - could be a network folder 
also. 
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g) Save to offline Cube – Once you have loaded a live cube from the cases, you have the option to save the 
entire cube data to a file (with the extension - .offlinecube) for offline use, when you are disconnected from 
the network. Offline cube can be saved in compressed or uncompressed format, the former option will 
enable you to reduce the file size considerably. 
 

h) Same as e. (above) 
 

i) Close the cube - This option closes the cube from the OLAP Statistics and free up the memory for loading 
another cube. 
 

 

View Menu 

Contains actions that you can perform on the current report view. 

 
 

a) Reset Chart/Grid - Empty all the member fields from the pivot as well as the data from the working area of the 
chart/grid. This is useful if you want to start over on a new report view. 
 

b) Synchronize Chart/Grid - This option allows you to reflect the state of the statistics between the Grid and the 
chart. It is particularly useful, for example, when you have built up a grid with aggregated data, but want a more 
visual representation of the statistics in form of graphs and bars. Also note that, the synchronization will be 
done to the other part (grid or chart) based on the current interface.  
 
For example, if you are in the grid view, and if you pressed ‘Synchronize Chart/Grid’ it would read the state of the 
Grid view and impart the same state (same members and measures) to the Chart view and vice versa. Each of 
the Grid and Chart view can be worked independently as long as you don’t press this synchronize option. 
 

 

OLAP Grid panel 

The OLAP Grid control comprises of a multi-dimensional table with expandable nodes. These nodes group and 

display data according to the hierarchies used to define the measures and dimensions upon which the underlying 

data has been organized. A unique feature of control allows for building the OLAP-reports of the exceptional level 

of complexity. In tandem with the OLAP Chart, the OLAP Grid provides an ideal means of clearly conveying data 

to the user. 

 

 

OLAP Chart panel 

While OLAP Grid allows working with numbers, the OLAP Chart allows representing the project data graphically. 

This gives you a unique opportunity to analyze their project data visually, dealing with charts rather than 
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numbers, which is much easier to perceive. 

 

 
 

 

Cube structure panel 

The panel contains the Cube structure - measures and hierarchies as a tree. The measures are grouped in the set, 

displayed in a branch. Rest of the tree nodes are the dimensions that contain hierarchies. 

 

 

 - Measure 

 - Dimension 

 - Attribute hierarchy 

 - Multilevel hierarchy 

 

To select a measure for display you need to drag-n-drop it to 

the Measures panel or the data area.  

 

To select a hierarchy for display – drag-n-drop it to the 

hierarchy area or the pivot panel (rows or columns area). 

 

• Measures are grouped in the Measures category. 

• Hierarchies are sorted into folders - dimensions. If there's 
only one dimension in a hierarchy, it will be displayed in the 
tree root. 

 

Both hierarchies and measures have their own menus. Right click will call the context menu that gives you an 

option to place the element where you like. You can also filter the selected element (see Filtering hierarchies and 

measures) or place it to the selected panel. 

 

 

Pivoting panels 

A pivot table lets user design the report online by dragging and dropping measures, dimensions and levels into 

the pivoting panels. Note that the column panel may contain no more than one (!) measure. Panel elements can 

be dragged with the mouse to other panels. To filter elements, press the Filter button (see Pivot panel view) or 

use the appropriate items from the context menu. 
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Measure panel 

Measure panel consists of groups of measures that make up the charts' vertical axes (see Measure panel 

components). Each group of measures corresponds to a set of charts in the data area. Groups of measures are 

situated in the main part of the panel. 

 

 
 

You can drag measures from one group to another, or extract measures from groups to delete them. To create a 

new group, you need to drag a measure to a place on the panel not occupied by another group or to the <drop an 

item to create a new group> panel. 

 

Clicking a mouse button on measures will call the context menu. From here, you can move a measure to one of 

the pivot panels or to the modifiers axis, or assign a measure filter. Also, you can assign the marker type of a 

chart point and its color. 

 

 

Filter panel 

This statistical tool allows for easy selection on what data you want to see and what you don’t. You can apply 

powerful filters to anything including hierarchy members, and measure values, thus leaving out the unimportant 

data. You can sort the data to see, for example, the top 10 values and then you can gather the rest of the values 

into a single group, so you only have what you really need. 
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The filtered elements (hierarchies and measures) 

are automatically transferred to the Filter panel. 

To assign a filter, you have to move an element 

to the Filter panel. If the element hasn't been 

filtered the appropriate visual filter editor will be 

shown, similar to the one on the right: 

 

 
 

 In the Filter panel, you can call the Filtered Element Editor individually for each element.  

 
 

 

Working Area 

The OLAP-slice data is displayed in working area. In its upper part there is a menu for the quick access to the 

frequently used commands². The rest is occupied by the current OLAP-slice and consists of the following parts - 

Cube Axis headers, Cube Axes, Data Axes, Data Axis headers, Chart Panes. 

 

You can change the view of the slice by relocating measures and hierarchies within the environment panel. When 

you start dragging an element, all the possible locations, where it can be dropped to, will be highlighted. Most 

elements have context menus that duplicate the mouse actions and provide additional control functions for 

managing the slices' view. 

 

Grid working area 
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Chart working area 

 

 
 

 

  

 

  



 

 

 Back to TOC 

P
ag

e1
5

6
 

20.2 Working with the OLAP grid  
 

The OLAP Grid view is comprised of a multi-dimensional table with expandable nodes. These nodes group and display data 

according to the hierarchies used to define the measures and dimensions upon which the underlying data has been organized. 

In tandem with the OLAP Chart view, the OLAP Grid view provides an ideal means of clearly conveying data to the user. It is 

highly navigable and quickly provides detailed information to the user. The speed with which data recall occurs and the strong 

formatting the grid enforces ensure data is always presentable and easily understandable. Consequently, OLAP Grid views can 

easily be ported to spreadsheet applications for report compilation purposes.  

 

Additionally, the OLAP Grid view allows users to effortlessly add and remove categories, filter and sort categories, and drill up 

or drill down on data using powerful built-in menus. One of the greatest benefits this affords is that it allows users to explore, 

navigate and refine data until the desired snapshot is achieved. Once in place this snapshot can then be reflected in a 

complementary chart. This is possible as OLAP operations in Grid view can be synchronized with Chart view. These two data 

views can then be deployed side-by-side or on top of one another. 

 

 Unicode support.  
 Simultaneous display of several different measures in the Grid.  
 Simultaneous drilling down based on different parameters: up to the nearest child, up to the next level, up to the next 

hierarchy.  
 Saving and restoring the current OLAP-slice.  
 Hierarchy members grouping (including multilevel and parent-child hierarchies).  
 Separate sorting on different hierarchy levels. Possibility to override any sorting method.  
 Ascending or descending sorting based on the cell values in any column of the Grid.  
 Filtering of hierarchy members with or without applying these filters to the OLAP calculations.  
 Auto filtering of the hierarchy members depending on their values in the Grid. Major/minor members selection, either 

based on their rank or on the Pareto principle.  
 Replacing hierarchy members by drag-n-dropping them within the Grid.  
 Auto sizing of cells depending on their contents.  
 Flexible export to MS Excel, HTML, GIF, JPG, PNG, BMP, CSV, TXT, PDF formats. 

 

Operating the OLAP-slice 

The OLAP-slice data are displayed in a table, whose appearance may be amended to some extent. For operating the current 

OLAP-slice there are the following functions available: 

1. Navigation 
2. Selecting and copying data 
3. Drilling, sorting and moving hierarchy members 
4. Operating context menus 
5. Filtering data 
6. Editing data 
7. Setting the column width 

  

1. Navigation - You can easily navigate the data using the keyboard: 

Button  Action 

Home  Move to the first cell of the row 

End  Move to the last cell of the row 

PageUp  Move one page up 

PageDown  Move one page down 

Ctrl+Home  Move to the top left cell 

Ctlr+End  Move to the bottom right cell 

 

Using the mouse, you can scroll the table up and down. 

Mouse Action Component Action 

Scrolling the mouse wheel Vertical scrolling of the table 

Scrolling the mouse wheel with the Shift button held 

down 

Horizontal scrolling of the table 
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2. Selecting and copying data - The data area in the component can be selected like everything else in Windows: 

• Select all the cells pressing Ctrl+A;  
• Capture the area with the mouse;  
• Change the boundaries of the selected area with direction buttons, holding down the Shift button.  

You can copy the data from the selected area to the clipboard by pressing Ctrl+C. If there’s no selection, pressing these buttons will 
copy the whole OLAP-slice to the clipboard. 
 

3. Drilling, sorting and moving hierarchy members - To 
perform the drilling of the hierarchy members press 
buttons on the Grid cells. If there’s only one drilling 
button in a cell, then, instead of pressing it, you can 
double-click the cell itself. By default, the drilling 
buttons are shown only in the cells under mouse. To see 
all the buttons, press the Ctrl button. The last cells in 
the column area of the hierarchy members allow 
showing the sorting direction. A pointer that indicates 
the descending order of data illustrates it. You can 
manage the sorting modes by single clicking on the cells 
of the specified area: they are changed cyclically 
[descending sorting] -> [ascending sorting] -> [no 
sorting]. 

 

 

4. Operating context menus -The context menu, 
called by right clicking a table cell, partly duplicates 
the OLAP-slice control functions. 

 
 

 

 

 

 

 

Hierarchy levels' menu 

The view of context menu of the hierarchy levels' area. There is a list of commands available in the context menu of the hierarchy 
levels’ area: 

Command Function 
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Show totals first Show the aggregated cells before all the rest 

Show totals last Show the aggregated cells after all the rest 

Don’t show totals Do not show the aggregated cells 

Default sorting Range hierarchy members by default 

Sort ascending Range the hierarchy members by values from the bottom to the 

top 

Sort descending Range the hierarchy members by values from the top to the 

bottom 

Aggregate all hierarchy 

members 

Aggregate all the hierarchy members (including hidden) 

Aggregate visible members only Aggregate the visible hierarchy members only 

Drill all down\ to the next 

hierarchy 

Drill all down to the next hierarchy 

Drill all down\ to the next level Drill all down to the next level 

Drill all down\ to the same-level 

children 

Drill all down to the same-level children 

Drill all up Collapse all the elements of this level 

Clear filter Remove any applied filters 

Filter on captions Set the filter for measures 

Show empty cells Show the cells with no aggregated values 

Create new group … Create a new group. It will appear at the first level of the 

hierarchy 

Copy selection Copy the selected area to clipboard 

Conditional formatting Show the Conditional formatting menu 

 

 

Hierarchy members' menu 

 
The view of the context menu of the hierarchy members' area 

 

Command Function 

Drill down to the next 

hierarchy 

Open the node up to the next hierarchy in the current area, ignoring 

all the lower levels of the current hierarchy 

Hide this member Hide the member 

Hide all members except 

this 

Hide all the members of the hierarchy, except the selected one 

Hide all members above 

this 

Hide all the members of the hierarchy above the selected one 
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Hide all members below 

this 

Hide all the members of the hierarchy below the selected one 

Show only the top Show the top elements of the level. Their number is specified in the 

sub-menu. If you specify a percent value there, then the picking of 

members will be such that their total value does not exceed the one, 

specified in the sub-menu. 

You can choose a threshold value from those offered in the 

appropriate menu item or set your own one, selecting Other from the 

menu. 

Show only the bottom Show the bottom elements of the level. Their number is specified in 

the sub-menu. If you specify a percent value there, then the picking of 

members will be such that their total value does not exceed the one, 

specified in the sub-menu. 

You can choose a threshold value from those offered in the 

appropriate menu item or set your own one, selecting Other from the 

menu. 

Filter on captions Set the filter for measures 

Create new group.. Create a new group on the current level 

Copy selection Copy the selected area to clipboard 

Conditional formatting Show the Conditional formatting menu 

 

The menu for groups of hierarchy members 

 
The context menu that appears above the group cell. 

 

 

 

 

Command Function 

Hide this member Hide the selected member 

Hide all members except this Hide all the hierarchy members except the selected one 

Hide all members above this Hide all the hierarchy members above the selected one 

Hide all members below this Hide all the hierarchy members below the selected one 

Show only the top Show the top elements of the level. Their number is specified 

in the sub-menu. If you specify a percent value there, then the 

picking of members will be such that their total value does not 

exceed the one, specified in the sub-menu. 

You can choose a threshold value from those offered in the 
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appropriate menu item or set your own one, selecting Other 

from the menu. 

Show only the bottom Show the bottom elements of the level. Their number is 

specified in the sub-menu. If you specify a percent value there, 

then the picking of members will be such that their total value 

does not exceed the one, specified in the sub-menu. 

You can choose a threshold value from those offered in the 

appropriate menu item or set your own one, selecting Other 

from the menu. 

Filter on captions Set the filter for measures 

Create new group Create a new group 

Delete this group Delete the selected group 

Clear this group Clear the selected group 

Rename this group Rename the selected group 

Copy selection Copy the selected area to clipboard 

Conditional formatting Show conditional formatting menu 

 

 

Measure values' menu 

 

 The context menu that appears above the group cell: 

Command Function 

Sort ascending  Range the cells in the column by values from the 

bottom to the top  

Sort descending  Range the cells in the column by values from the top 

to the bottom  

No sorting  Remove any sorting  

Filter on captions  Set the filter for measures 

Hide this measures Hide the selected measure 

Show as Specify the display mode of the current measure in 

the Grid: 

default 

percent aggregated value in the row 

percent parent element of the row 

percent parent element of the column 

percent total aggregated value 

Copy selection Copy the selected area to clipboard 

Conditional formatting Show conditional formatting menu 

 

5. Filtering data - The filtered elements (hierarchies or measures) are automatically placed on the filters' panel. To start filtering, 
move the element to the filters' panel. In case the element has not been filtered, the appropriate editor will launch (the Hierarchy 
Editor for hierarchies and the Measure Filter Editor for measures). In the filters' panel, you can launch an editor for each element 
independently. 
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The buttons for launching the editor ( ) are placed on the 
panels in the Hierarchy levels’ area. If the button looks like 
this ( ), it means the hierarchy had hidden members inside. 
Pressing the button starts the Hierarchy editor. 

 

 
 
6. Setting the columns' width - You can change the width of columns in the data display area by dragging the right boundary with 
the mouse. If possible, these changes will be saved during other operations with the table (like drilling, sorting, etc.) To return to the 
original width, double click the right boundary of the column where it is visible. In case there were such changes in the table that 
saving the assigned width of the columns was impossible (for example, if as a result of the Collapse drilling, the column with the 
assigned width has disappeared), it will be set automatically. Unfortunately, if you operate a big table, calculating the columns’ 
width takes up too much time. That is why if there are more than 10, 000 cells in your table, their width will be set to default, but it 
can be corrected later. 
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20.3 Working with OLAP Chart 
 

While the Grid view allows working with numbers, chart view allows representing your helpdesk data graphically. This gives 

you a unique opportunity to analyze helpdesk data visually, dealing with charts rather than numbers, which is much easier to 

perceive. Now it’s easier than ever to spot new trends and discover unknown problems in your data flow. The statistical tool 

will help you gain an insight into your data and make new discoveries. 

 

 
 

Tools panel 
This panel houses all the frequently used operations on the OLAP chart - save, export, print and display options. 

Button Function 

 Load the Grid state 

 Save the Grid state 

 Export OLAP-slice data 

 Print OLAP-slice data 

 Preview 

 Undo 

 Redo 

 Switch axes 

 Select the docking panels layout 

 Set the scale of Chart display 

 Select the color palette for measures 

 

 

Modifier panel 
Modificators are easy and powerful means of data representation. You can choose your data be shown in different colors, using 
different shapes and sizes, so that you can easy distinguish them in a single graph. You can simply place a dimension or a measure on 
a modificator’s pane and get the graph showing different values in a different manner. 
 
For example, you might place the "Problem Category" dimension on Color pane and get the Chart showing problem categories in 
different colors. Or you can place the "Cost" measure on Color pane to highlight the top rates of supporting the service requests. The 
same can be done for Shape and Size so that you can make your data perfectly distinguished. 
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The layout of panels and hierarchies on the Modifier panel allows you to change the appearance of the displayed slice. When an 
element is placed to the modifier panel (except for Details), its legend will contain the display parameters. If you modify the color 
and shape of an element, the appropriate parameters can be amended. 
 

Modifier The changes made upon placing a Chart element to the modifier area of... 

a measure a hierarchy 

 

  

The color of the Chart elements will be 

chosen from the standard set of gradient 

colors  

 

Hierarchy members will be painted with 

the colors from the current palette 

Color The elements with the minimal value will 

be painted with the first of the gradient 

colors, and the elements with the 

maximal value - with the last one 

 

N/A 

Size Depending on the value of the measure 

the size of the Chart points will vary 

from the minimal to the maximal. 

 

Hierarchy members will differ in size 

Shape Forbidden Hierarchy members will differ in shape. 

If the number of hierarchy members will 

exceed the number of available shapes, 

some of them will be used more than 

once 

Details Forbidden The panels will display series for all 

hierarchy members 

 
If a measure is placed on the Color pane, its values range is mapped to the given colors range so that it’s tremendously easy to spot 
the top/low values. If you select the discrete gradient type, you'll be able to set threshold values for filling the Chart elements. While 
the continuous gradient will let you evaluate the trend as a whole. To select the gradient type and tune its content, turn to the 
legend panel. 
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The Legend panel 
The panel contains descriptions of the modified elements. 
The value, shape and color of a legend element can be 
edited. 

Setting the Color legend 
To select a color, simply double-click the appropriate element 
and choose a color from the pop-up editor. 

 

 

Setting the Gradient legend 
To edit the gradient, double-click the element and tune the settings in the 
editor. In the Gradient Editor there are: 

• a set of pre-made gradients;  
• selecting gradient option (continuous or discrete);  
• creating a gradient with a set number of intermediate colors option;  
• setting threshold in per cent and measure values option;  

 

Selecting threshold color option. 

 

 

 

 

Setting the Shape legend 
The shape selection is made through the context menu. This 
option is available only for points or lines Charts. If the 
number of hierarchy members exceeds the number of 
available shapes, they will be repeated. 
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Chart Panes 
The bulk of the OLAP-slice data are placed into cells with Charts. Each measure group has its own set of panes.  
 

 
Measure groups with corresponding Charts in the working area 
  

Chart Type 

In the upper left part of each Chart, there will appear a 
context menu for selecting its type. There are six (6) charts 
that you can use, namely, Point Chart, Histogram, Point 
Shape Selection, Lines, Curved lines and Step lines. By default, 
the Histogram is used. 

 

The size of Charts can be changed to some extent. To expand 
a Chart along either one of the axes, you need to capture its 
boundary with the mouse and drag it. You can change the 
size along both axes (and return to default) through the tool 
menu in the upper part of the working area. 

 
Chart type menu 

 
  

Hot keys for changing the scale 

Ctrl+* Reset Scale to 1:1 

Ctrl+Num+ Zoom In 

Ctrl+Num- Zoom Out 

 
Navigation 
If the content of the Grid exceeds the client area, the scroll bars will appear. You can scroll down the data using the mouse wheel. To 
scroll the Grid in the vertical direction, turn the mouse wheel, while holding Shift. 

 
Selecting Data 

You can select Chart points with the standard Windows' method. Holding down the Ctrl button, you can add selected points, 

holding down the Shift button, you can select the horizontal range. You can filter the Grid's points while selecting. In that 

case, the corresponding hierarchy members will be filtered automatically. 

Selecting and filtering parts of Charts 

a. Selecting some of the Chart points 
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b. Selecting the Filter command 

 

 

c. The result 

 

Note: When moving the mouse cursor over a data axis, you are able to select a continuous range of members (if the axis is 
composed of them) or a range of values in Charts. 

 
 

Filtering hierarchies 

In case you need to collect data not from the whole Grid, but just from a part of it, the component has a few functions at your 
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disposal: they let you select or remove elements from the slice. Also, there is a standard option of exporting data into a 

number of formats and printing out the content of OLAP-slices. The simplest way of selecting data is through the context 

menu. When you click a hierarchy member on the Cube axis, there is a set of commands for quick operations with members: 

• Hide this member  
• Hide all members except this  
• Hide all members above this  
• Hide all members below this  

Filter on hierarchy level 
The Filter area of the Editor becomes visible only in case if filtering by hierarchy levels is available. To apply a filter to hierarchy 
members, you need to select a hierarchy level (if there's more than one) and assign the Filter condition in the Filter menu. In the 
same menu, there's a command to clear filter. 
 
Filtering hierarchy members 
If the search field is not empty, the "Find" command will make the component perform a search for hierarchy members, whose 
levels contain the specified string. You can narrow the search results by checking the "Exact matching" box.  
 

Filtering a single member of a hierarchy 
By default, the Editor is able to select any number of hierarchy members. To switch to the single-select mode, uncheck the 
"Multiselect" box. In that case, only one the hierarchy member with all its parents and members will be selected.  
 

 
  

Filtering measures 

There is a number of available parameters for filtering measures. In the same Editor, you can clear the filter. 
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20.4 Predefined Reports 
 

Predefined reports allow you to quickly and easily retrieve information for 

common inquiries. Reports play a vital role as far as a Help Desk product is 

concerned. Requests that are open, closed or overdue at any instant of time, 

which person or department is sending the most number of requests & who is 

attending to the requests can all be known from the readymade reports 

available with the statistical tool. Each pre-defined report works in both OLAP 

grid and OLAP chart view.  

  

There are several predefined reports in each of the report categories, and 

each report is run directly on a mouse-click from the tree view. Around 40 

reports are made available for instant details about the help desk activities. 

Any of the predefined reports can be also be edited so you can customize the 

report to return specific results: 

 

• Reports by Assets 

• Reports by Cases 

• Reports by Callers 

• Reports by Date/Time 

• Reports by Problems 

• Reports by technicians 

 

All these categories have reports available based on Department, Priority, 

Requester, Technician, Category and Request Date. 

 
 

Some sample OLAP charts of the predefined reports 
 

A) Time spent on Asset 

 

 

B) Cases Count by Origin 
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C) Average time spent on caller 

 

 

D) Due date  

 

 
  

E) Cost per problem category 

 

 

F) Time spent by technician 
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20.4 Printing, exporting statistical data and charts  

 
Now that you have successfully designed a report, you might want to save it for future reference or share it with others. 

Reuse your work! You can now save data snapshots to HTML, BMP, CSV, GIF, HTML, JPEG, PDF, PNG, TIFF, TXT, XLS and XML 

as a simple way of reusing your data for documents and spreadsheets. Depending on the active view (Grid or Chat), the saved 

file would either take the grid data or the chart. 

 

 

 

 

Available export formats in Chart View  Available export formats in Grid View 

Printing 
You can print your report to share it with others using the built-in Print Preview window. You can tune your page/printer settings 
before printing. Also, if you feel like sharing the report through the net or by email you can easy export it to a wide range of formats 
including PDF, XLS, CSV, JPG, etc. 

 

 

Export Settings -This tool allows you to customize the appearance of the reports to be printed or saved to a file format. You can 
specify the page size, orientation, headers & footers and color of the fonts and page background. 
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21. Contact Manager  
The Contact Manager is a consolidated view of all available contacts in the caller and technician lists, listing the email address, 

mobile and phone numbers. A quick correspondence can be initiated to a particular contact in a single click via email, SMS or 

phone call. 

 

  

 

Compose an email with the contact email address already populated in a new email inspector window. 

 

 

 
Allows you to choose a knowledge base article and then insert it on a new email with the contact email address 
already populated. 
 

 

 

 

Allows you to choose a FAQ answer and then insert it on a new email with the contact email address 

already populated. 

 

 

 

Compose a SMS message to send it to the mobile number of the contact. 

 

 

 

Make a call (either Skype or attached phone) directly to the mobile number of the contact. 

  

 

 

Make a call (either Skype of attached phone) directly to the telephone number of the contact. 
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22. Archive Cases 
Over time, as the number of cases and emails in Personal Helpdesk folders build up, the size of the folders and mailbox increases 

too. And one pitfall with Outlook having folders/mailboxes with thousands of case items/emails is the sluggish performance you will 

perceive in its normal operation.  

For instance, if the resolved cases contain thousands of old cases, and assuming there are other thousands of associated emails in 

the Personal Helpdesk History folders, when you try to open an existing case, it may take longer to load and show the form and the 

fields. This is because Personal Helpdesk scans your resolved cases folder for those cases that are related to the opened case (in 

terms of the caller, asset or company). And this scanning process will take time if you have thousands of cases and emails in the 

Personal Helpdesk folders. Therefore, archiving old cases (say older than 30 days) and their associated emails out of Personal 

Helpdesk folders (i.e., to a PST or another mailbox or public folder) would greatly help reduce the scanning/probing time thereby 

increasing responsiveness and performance of Outlook and Personal Helpdesk. 

Two modes of archiving old, resolved cases are supported: 

a) Archive cases to a PST 

b) Archive cases to another Shared mailbox or Public folder.  

This is the recommended way of archiving as it overcomes the limitation with using a PST data file (which is, PST file can't be 

accessed and opened simultaneously by more than one person in their Outlook even if the PST file is shared on a network folder). 

Further, with this technique, the archived cases are searchable from Personal Helpdesk and could be included in Summary Reports 

and OLAP Statistics too. And when a reply to an archived case is received, Personal Helpdesk would automatically add that email to 

that case and re-opens it (i.e., the case would be un-archived and moved to the Ongoing Cases automatically). Moreover, only on 

this option, you can enable the auto archiving feature where the Personal Helpdesk add-in would scan for old resolved cases and 

their emails for archiving. You can define the number of days old/resolved cases that are to be kept in the Personal Helpdesk > 

Resolved Cases folder before they are moved to the archived folder. 

 

In both options, emails associated with the cases are also archived. At any time, you can retrieve back the archived cases from the 

'Retrieve archived cases/emails' (second) tab. You can either display all the archived cases or apply a filter search using keywords or 

by technicians or problems. And choose those particular cases that you want to retrieve back to the resolved cases (or re-open them 

to the Ongoing Cases folder). 
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23. Customer Web Service (CWS) site 
The Customer Web Service (or CWS which we will refer to often in this manual) is an AJAX enabled ASP.NET 2.0 website. It provides 

a rich set of tools and interactivity with the live helpdesk ticket data stored in the exchange server. Your customers can submit new 

support requests via a webform, check status of a support case and check out the knowledge base for possible workarounds to their 

problem before requesting for support. Furthermore, existing callers can login to the Caller Web Access (CWA) website to track all 

their support cases, escalate or withdraw ongoing case, re-open closed case etc. 

How does it work? 
The Personal Helpdesk web case submission allows for your end-users and customers to submit their service request through an 

intuitive, easy-to-use web form interface; needing only their favorite web browser. 

The Customer Web Service (CWS) is a collection of ASP.NET webpages that cater to the helpdesk end users on the web. It consists of 

a structured support request submission webform, a support case status querying form, a self-service knowledge base and a special 

web interface exclusively for existing callers to access their support cases online. All these sections are available to any users 

accessing the customer service website except for the Caller Web Access (CWA) site, where only existing users are allowed to do so 

from the web. Unlike other traditional web-based helpdesks, CWS site in Personal Helpdesk does not require a dedicated database. 

Instead, the support cases submitted by customers are directly feed into the Personal Helpdesk folders (i.e., stored in Exchange 

server). Your helpdesk add-in services requests coming from CWS site and behaves like a server. That is why, we recommend that 

you configure your system to run 24x7. 

 

 
Allows end-user to enter information on their problem on a structured web form. 

 
Allows end-user to check and track the status of their support cases online. 

 
Allows end-user to browse or search through the web-based knowledge base articles to find a solution on their problem. 

 
Allows existing callers to access their exclusive member area online such that they can view support cases history, submit 

new support request directly, escalate or cancel ongoing cases or reopen existing resolved cases. 

 

Why is Online Customer Service Important?  

Web-enabled customer service provides a variety of benefits. In addition to the fact that many prospective customers will refuse 

to do business with an organization if they don't offer some level of online support, benefits include:  

o 24/7 customer service capability  

o immediate response to customer inquiries  

o meeting/exceeding constantly evolving customer demands  

o improved customer satisfaction and customer relationships  

o cost savings  

o automation of repetitive tasks makes it easy for customers to do business with you  

o re-allocation of customer service staff to value-add tasks  

o acquisition of invaluable customer feedback and requests 
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Configuration Guide on IIS 
 

Before end-users and callers can start using Customer Web Service (CWS), you need to first setup and configure certain 

settings, in the web access administrative panel in Personal Helpdesk Outlook, and then on the IIS web server.  

 

To install, setup and use Customer Web Service (CWS), the followings list the requirements on both the web server and the 

customer’s system. 

 

 

On the Web Server system 

• Microsoft Internet Information Server 

• Microsoft ASP.NET 2.0 Enabled 

• Write permission for ASP.NET users on a temporary subfolder under CWS IIS folder 

Note: As there is no direct interfacing between the CWS site and your Exchange server, the IIS web server does 

not need to be on the same windows server as that of your Exchange server, but should be under the same 

office network. 

 

On the Customer’s system 

• Any Web browser 

• Internet Connection 

 

 

The followings list all the steps required to be performed to get CWS website running in few minutes. 

 

Step 1: Setting up an Application under IIS 

Step 2: Set appropriate network permission to the IIS shared folder 

Step 3: Extract/Copy all Customer Web Access application files to the IIS web folder 

Step 4: Set ASP.NET permission on Temp sub-folder 

Step 5: Configure web Access specific settings in Personal Helpdesk add-in 

Step 6: Write/Update XML metadata files from Personal Helpdesk for Outlook 
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Step 1: Setting up an Application under IIS 
The first step in setting up the Customer Web Service (CWS) site requires creating a new application under your IIS server. In this 

document, we discuss the configuration of an application on your default web site under your IIS. 

To create a new application, right-click the site and select ‘Add Application…’. 

 

You will be prompted with the ‘Add Application’ dialog box. 

 

 

First, set the CWS application to use .NET CLR 2.0 application pool by clicking ‘Select…’ button in the ‘Application Pool’.  
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Type the alias for the Application, say, CWS and specify the physical folder on the local server to map to this alias. In this case, the 

physical folder on the server is C:\Inetpub\wwwwroot\CWS 

 

Click OK. The image below displays the result. 
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Step 2: Set appropriate network permission to the shared folder 
The just created 'CWS' IIS Application now needs to be set as a shared network folder for all the helpdesk technicians that uses 

Personal Helpdesk for Outlook. Data interchange between the customer web access and the Personal Helpdesk add-in in Outlook 

uses XML formats and are written to a temporary subfolder 'Temp' under the application folder. Due to this requirement, all 

helpdesk technicians working in Outlook will need to have full control over the 'CWS' network folder. 

Right-click the CWS application from the tree view and click ‘Edit Permissions…’ 

 

We need to grant full control to this folder (e.g. C:\Inetpub\wwwroot\CWS) in both Sharing and Security tabs. Let us start with the 

first one. Click the Sharing tab > Advanced Sharing… 

From the ‘Advanced Sharing’ box, enable the option 

 ‘Share this folder’.  

 

 

And then click ‘Permissions’. 
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Once you are in the permissions dialog, you will see that 

by default, any users on the local network have read 

permission over the shared folder. For our needs, we 

need to allow all helpdesk users to save/update files 

under this folder. So, either you can add individual user 

or a group (if you have it defined). 

 

In our example, we have defined a group 'ServiceDesk' 

comprising of all helpdesk users so that setting 

permission for all users can be done in a single click. 

Check the option 'Full Control' to allow all technicians in 

the helpdesk team to save/update 'Customer Web 

Service' specific metadata XML files. 

 

 

Likewise, add the same helpdesk group (e.g. ServiceDesk) 

under the Security tab and grant 'Full Control' access.  
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Step 3: Extract all Customer Web Service (CWS) application files 
Now that we have created an exclusive web-enabled physical folder on the server and granted full control to all helpdesk users (step 

1 and 2 respectively), the next step is to extract all the files and subfolders from the Customer Web Service zip archive (e.g. CWS.zip) 

to the shared network IIS folder. 

This CWS.zip is installed with Personal Helpdesk, and is located under the following folder in your system: 

C:\Users\USERNAME\AppData\Roaming\AssistMyTeam\Personal Helpdesk Resources 

The contents of 'CWS.zip' are shown below: 

 

Extract all the files and subfolders under the zip (e.g. CustomerWebService.zip) file to the network shared web-enabled Customer 

Web Service (CWS) folder. For example, \\192.168.1.4\CWS where '192.168.1.4' is the windows server and 'CWS' being the web-

enabled folder (either configured as a website or virtual directory under an existing website in IIS). If step 2, if the permission (e.g. 

full control) was successfully set, the files and subfolder would be extracted/copied to the network share. 
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Step 4: Set ASP.NET (Internet Guest Account) permission on Temp folder. 
The Customer Web Service functionality is built upon ASP.NET 2.0 and AJAX technology. Typically, an ASP.NET application requires 

read, execute, and list access for the ASP.NET account (also known as Internet Guest Account) for the web site root (for example: 

D:\inetpub\wwwroot\CWS or any alternative site directory you may have configured in IIS), the content directory and the 

application root directory in order to monitor for configuration file changes. The application root corresponds to the folder path 

associated with the application virtual directory in the IIS Administration tool. 

Under your IIS server, you have multiple subfolders under the CWS application. The special interest that we have now is for the 

'Temp' folder, as this is the folder that saves uploaded attachments from support request case temporarily. Hence, the ASP.NET 

account needs to be configured to have ‘Full Control’ over this 'Temp' folder. You do that by right-clicking 'Temp' folder > ‘Edit 

Permission…’. 

 

From the Temp properties dialog box, click the ‘Security’ tab, and click 

the ‘Edit…’ button to invoke the ‘Permissions’ tab. 

In the ‘Permissions’ dialog box, select the ASP.NET (Internet Guest) 

account. Different version of IIS has different ASP.NET account name. 

For example, in IIS version 5 (windows 2000 server), it is ASPNET, and 

in IIS version 6 (windows server 2003), it is IIS_WPG group whereas in 

IIS 7 and above version (Windows 7 and above), it is IIS_IUSRS group. 

In the screenshot below, we have IIS 7 version and hence, the IIS_IUSR 

group is allowed 'Full Control' over the 'Temp' folder. 
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Step 5: Configure CWS specific settings from Outlook 
The Customer Web Service (CWS) site does not make use of a database to store the helpdesk settings and lists. Instead, the data and 

settings are stored as XML metadata files and are saved/updated from the Personal Helpdesk add-in interface in Outlook. The 

document takes you to finer detail on various web access settings that need to be configured in the administrative tool, before 

saving/updating the XML metadata files in the IIS folder. 

Displayed below is a part of the Customer Web Service (CWS) settings dialog. To save/update the CWS specific XML metadata files 

from Outlook to the shared network web-enabled folder (on the server), it needs to know the full UNC folder path. If the network 

folder resource requires a network credential, then you will be prompted to enter one 

 

The Caller Web Access (CWA) site, which is a part of the Customer Web Service (CWS) site, requires a user credential for caller to 

access their support cases online. You can define this credential (e.g. password) in the Personal Helpdesk Callers list dialog. 

Alternatively, a random password can be generated automatically when a new caller is added to the Callers list. 
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Step 6: Write/Update XML metadata files from Outlook 
The last remaining step is to save/update the Customer Web Service (CWS) specific XML metadata files in the CWS network web-

folder. The XML metadata files contain the required Personal Helpdesk lists and settings and these files feed data to the Customer 

Web Service applications when end-users submit new support requests via web-form or when caller login to load their support 

cases. 

Before any XML data files can be updated, you need to specify the network share that was configured in Step 2. If the appropriate 

permission was set, clicking the 'Update data' button generate all the required XML files. 

 

 

Now, open your web browser and point to the CWS URL. Usually the URL is in the format http://SERVER/CWS/. For example, in our 

instance, it would be http://byteStation/CWS/ 

 

http://bytestation/CWS/
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Support Request Web Form 
New support requests are submitted in Customer Web Service (CWS) site via a web form. The form consists of a HTML WYSIWYG 

editor, fields for caller contact details and fields the end-users can select to specify a related problem from the populated drop-

downs. End-users can also upload any number of files as attachments. When an end-user submits a support request, it is flagged to 

be processed by one of the technician running Personal Helpdesk in Outlook at that point of time. Once a new support case is 

logged, a confirmation email is then sent out to the caller. The email can contain caller credentials (e.g. username and password) 

that caller can use to login to the Caller Web Access (CWA) site to track their support cases online. 

 

The problem description retains the same formatting and looks (as in Outlook) in the web case form. If there are any active 

knowledge base articles, the relevant articles would show up based on the selected problem category/type. This facilitates the end-

user to lookup the related articles for possible solution to their problems before submitting a new support request. It not only 

addresses the problems of the end-users instantly, but also prevent any recurring/redundant problems to be reported to the 

helpdesk, thereby, making the helpdesk resources available to other tasks.  
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Case Status web form 
 

Very often many support cases are logged quickly, but the resolution to the problem may take some longer (in days, weeks) when 

the support technician starts working on it. In such situation, it might not be feasible to get the caller in the communication loop 

regularly. More importantly, the helpdesk might be overwhelmed with the status queries on the pending support case and it may 

unnecessarily divert valuable resources and time. With a web based status tracking, anticipating callers can check the status and 

other details online very quickly without having to write/call the concerned helpdesk. It also avoids burden on the helpdesk and let 

the technicians to focus on problem solving rather than answering status of case. 

 

 
Email address of the caller. 

 
Case number of the particular support case allotted to the caller. 

 

To retrieve the status and other details of a particular support case, both the specified caller 'E-mail' and the 'Case Number' should 

be valid i.e., the specified case number should have been allotted to the caller email. This means, if the case number specified exists, 

but not allotted to the specified caller email, then it’s an invalid pair. 

 



 

 

 Back to TOC 

P
ag

e1
8

7
 

Web knowledge base 
 

The knowledge base articles in the Personal Helpdesk folder (in Exchange) can be published to your website so that end-users and 

customers experiencing technical challenges can self-service the answer to their problem by accessing the web-based knowledge 

base. End-users may click through the tiered problem categories and types to find the self-service answers they are looking for. Self-

Service articles may also be searched via keywords.  

 

 

Primary category dropdown that lists all available problem areas. 

 

Secondary sub-category drop-down that is defined for each primary category. 

 

Search for relevant knowledge base articles via keywords. 

 

The knowledge base articles listing in a tree that matches the specified category/sub-category or the searched 

keywords. Each article link can be clicked to load the corresponding knowledge base. 
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Caller Web Access (CWA) 
 

The Caller Web Access is a set of ASP.NET web interfaces through which callers can login to track the progress and status of their 

support cases. Allowing callers to have access to their helpdesk cases through the comfort of a web browser, not only provide self-

served information exchange in matter of seconds, but also relieve the helpdesk staffs from diverting their valuable time in replying 

to non-critical calls and emails back and forth with the callers. These instead help the helpdesk to concentrate on its critical goals 

and missions.  

 

The site requires caller to authenticate their credential by inputting their email address and password that was provided by the 

helpdesk staff via email/SMS. The Caller web login page is given below: 

 

Once logged on, the caller would be able to see all the support cases allotted to him/her under the 'My Cases' member area over a 

period of time. The cases are sorted by the last modified date/time in descending order. The caller can click any one of the support 

case and open the selected case in a new window to have a detail view.  

With the Caller Web Access, a caller can: 

• Submit new support request 

• Escalate ongoing support case 

• Withdraw ongoing support case 

• Re-open closed support case 
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The case form in CWA consists of many fields including custom fields that might be used for in-house properties. Most of the fields 

are read-only, and only few such fields such as those of caller information are editable by the caller. However, to further escalate the 

case (holds true if the problem is still ongoing), there is a WYSIWYG editor with which a new description related to the problem can 

be composed and submitted instead of the hassle of composing emails and forwarding it to the helpdesk email address. Callers also 

have the flexibility of uploading any number of files as attachments to the current case. 

If the caller has already found a solution to the problem, or was helped by a solution recommended earlier from the helpdesk, 

he/she can simply close/withdraw the case. 
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24. Uninstalling Personal Helpdesk add-in  
 

To uninstall the Personal Helpdesk add-in from your computer, follow the steps outlined below: 

 

Step 1: Go to ‘Control Panel > Programs and Features’. Scroll down to select ‘Personal Helpdesk (x86) or (x64)’ and click 

‘Uninstall’ as illustrated below: 

 

 
 

Step 2: A dialog confirmation follows asking for confirmation. Click Yes.  

 

 
 

Step 3: The Personal Helpdesk setup will now start the un-installation process. Make sure that Microsoft Outlook is not running 
(even under the task manager). 

 
Step 4: After the add-in uninstallation is successful, you can start Outlook and delete the ‘Personal Helpdesk’ folder that was created 
under your Exchange mailbox or Public Folder. 
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25. Important links  
  

Personal Helpdesk for Outlook - Home page 

Go to the official website of Personal Helpdesk for Outlook.  

  

Video Tutorial clips  

Watch video tutorials that teach you how to install, configure and work with Personal Helpdesk.   

   

Purchase license  

Purchase a license for Personal Helpdesk for Outlook.   

   

Knowledgebase articles  

Looking for an in-depth understanding of this application? Browse through a series of knowledge base articles 

on Personal Helpdesk online.  

   

Support Maintenance contract  

At AssistMyTeam, we're committed to give you the best support for all the products that we offer and more! 

The AssistMyteam Support Contract helps you use our products more efficiently and work out any issues that 

you encounter during the course of their use.   

   

Submit an online support ticket  

Use this web form to create a ticket with AssistMyTeam Technical Support.   

   

https://www.assistmyteam.com/helpdesk-addins/
https://www.assistmyteam.com/helpdesk-addins/
https://www.assistmyteam.com/helpdesk-addins/
https://www.assistmyteam.com/helpdesk-addins/video-tutorials/
http://www.assistmyteam.net/TeamTimeSheet/TutorialClips.asp
https://www.assistmyteam.com/helpdesk-addins/purchase/perpetual-license/
http://www.assistmyteam.net/TeamTimeSheet/Purchase.asp
https://www.assistmyteam.com/helpdesk-addins/kb/
http://assistmyteam.net/KB/index.php?option=com_content&view=category&id=3
https://www.assistmyteam.com/support/
http://www.assistmyteam.net/support/
https://www.assistmyteam.com/support/submit-ticket/
http://www.assistmyteam.net/support/submitTicket.asp
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